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S Corporations (1120S)

The basics of data entry for an S corporation (1120S) return are the same as for a 1040
return. Navigation through data entry, field- and screen-level help, and keyboard
shortcuts all function as they do in the 1040 program. See the Drake Software User's
Manual: Tax Year 2015 for the basics of using the program. (The manual is available
on the installation CD and on the Drake Support website: Support. DrakeSoftware.com
> Training Tools > Manuals.)

What’s New in Drake for S Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The
2015 program reflects all changes to credits and deductions, including discontinua-
tions. For details on the new regulations for the 2015 tax year, see the IRS instructions
for Form 1120S.

The following changes have been made to the 1120S program in Drake for the 2015
tax year.

Short-Year Returns

Starting this year, short-year return election information is entered on the Year screen,
available on the Miscellaneous tab of the Data Entry Menu or from a Year link on
screen 1, rather than on the Election Options (ELEC) screen.

For more on using the Year screen, see “Short-Year Returns” on page 5.

For more on using the ELEC screen, see “Elections” on page 41.

EF “ACK” Page

Similar to federal Form 9325, Acknowledgment and General Information for Taxpay-
ers who File Returns Electronically, generated with 1040 returns, the federal and state
business packages now generate an “EF_ACK” page for the main forms of federal
returns and “(ST)EF_ACK” page for the main forms of state returns.
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This is a Drake-generated form that serves the same purpose as Form 9325: an
acknowledgment that a return has been transmitted through Drake and received by the
IRS or the applicable state agency.

When a return is e-filed and you receive a “P” ack (indicating that the return is being
processed) or an “R” ack (for a rejected return), the top section of the EF_ ACK is
completed, noting the name and address of the client, the return type, the ERO who
transmitted the return, and a check mark indicating the return was received by the IRS
or applicable state agency.

When you download and process your acknowledgments and receive an “A” ack, the
second section of the EF_ ACK is generated, indicating the return was accepted by the
IRS or state agency and the date the return was accepted. The submission ID number
is also included.

Expanded Officer/Partner Information

Drake has added a Suffix drop list and Professional text box to the officer information
sections of the PIN screen and to the 1125-E Officer Information screen. These new
fields allow you to enter such designations as “Jr.”, “Sr.”, “III” to the name of the cor-
poration officer, and such professional designations as “Dr.” or “Ret.”

Royalties Worksheet

Instead of generating Form 8825, Rental Real Estate Income and Expenses, when roy-
alty income and expenses are listed on screen 8825 (and Royalties is selected from the
Type of property drop list), Drake now generates the Royalty Worksheet
(“WK_SROY” in View mode).

Instead of the royalties income and expenses flowing to box 2, “Net rental real estate
income,” of Schedule K-1, gross royalties now flow to Schedule K, line 6, “Royal-
ties,” and expenses to Schedule K, line 12d, “Other deductions.” These amounts are
also on the Royalty Worksheet.

Form 8825 isn’t generated unless it is otherwise needed.

Screens K and KFT

To promote greater accuracy in allocating Schedule K data to the individual share-
holder’s Schedule K-1, and to improve the detailed statements provided to sharehold-
ers on their K-1s, Drake has made several enhancements:

* Screen K is now a “tabbed” screen, with separate tabs for data entry of Income,
Deductions, Credits, AMT and Basis, and Other Information

*  More “Other” items, such as “Other” income, “Other” deductions, “Other” credits
were added, allowing a more detailed supplemental K-1 statement than ever
before.

* Information on foreign transactions is now entered on a separate KFT screen,
accessible from the General tab of the Data Entry Menu or from a link on the
Credits tab of screen K.)
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* In addition, Drake now generates a “Foreign Transaction Statement,” shown as
“WK_FTRS,” listing all the foreign transactions for an S corporation. A separate
“K-1 Foreign Transaction Statement” (K1_FTRS) is also generated, reporting
these foreign transactions for the individual shareholder.

For more information on using screen K, see “Schedule K: Shareholders’ Pro Rata
Share Items” on page 21.

N OTE To avoid duplicate entries, the “Schedule K - Most Common ltems”
have been removed from the INC screen.

Form 4562

Drake now produces a Form 4562 for each property on Schedule E and Form 8825
instead of one Form 4562 for Schedule E or Form 8825.

1099 Screens

We added two state-only income screens to the States tab of the Data Entry Menu:

* Screen 99M (1099-MISC) for miscellaneous income
*  Screen W2G, for gambling income

Form 5471 Information Return

Form 5471, Information Return of U.S. Persons With Respect to Certain Foreign Cor-
porations has been added to the 1120S package. This form is used by certain U.S. citi-
zens and residents who are officers, directors, or shareholders in certain foreign

corporations. Taxpayers who must file this form are described in the IRS instructions.

If your client must file this form, go to screen 5471 (accessible from the second Other
Forms tab) and enter the relevant information. Form 5471 will not be e-filed with the
return. File by the due date (including extensions) for that return.

For details on using this form, see the IRS instructions for Form 5471.

Before You Start

Actions you might need to take before starting an 1120S return in Drake include:

* Updating a prior-year return (if you prepared the tax return last year)
* Electing as an S corporation (if the corporation was not an S corporation last year)

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

* Asasingle return (updated one at a time) using Last Year Data > Update Clients
2014 to 2015 (recommended)
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When you open the return for the first time in the 2015 program and are prompted
to update it

With all other returns in the program at once using Last Year Data > Update Cli-
ents 2014 to 2015 (nof recommended)

Indicating an S Corporation

If the corporation is electing as an S corporation for the first time, it is necessary to
indicate this in the program.

S Corp Onscreen 1 in the General Information section, line A, enter the date of election as
Election an S corporation. On line E, enter the date incorporated. On line G, mark the check
box, “First year as an S corporation.”

Form 2553, Election by a Small Business Corporation, is required if the entity is mak-
ing the election with the return. In Drake, use screen 2553, accessible from the first
Other Forms tab or by clicking the Form 2553 link on screen 1.

If attaching a signed Form 2553 to the return as a PDF, mark the

N OTE Attaching Form 2553 as a PDF document box on screen 1. If not sent

as a PDF, the form must be mailed separately to the IRS before filing
the tax return. See Form 2553 instructions at irs.gov.

Changing To change a “C” corporation to an S corporation (1120 to 1120S):

File Type

oakrobd-=

Go to Tools > File Maintenance > Change File Type.
Enter the EIN of the entity.

Click Continue.

Select the new return type (Sub-S Corp 11208).

Click Continue to save changes.

Click OK.

Other Information and Overrides

Use screen 1 to enter the following additional information:

Resident State — If the corporation has a mailing address in one state but does
business in another, select the state in which the corporation does business from
the Resident State drop list.

Drake Codes and Overrides — The Other Information section of screen 1
includes fields for miscellaneous codes, invoice numbers, and several overrides.
See “Listing a Different Firm, Preparer, or ERO on a Return” and “Customized
Drop Lists” in Chapter 2, and “Miscellaneous Codes” in Chapter 5, of Drake Soft-
ware User s Manual: Tax Year 2015 for more information.
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Header Information

Screen 1 contains fields for the general information that is printed in the top section of
page 1 of Form 1120S.

Name and Address

Tax Year

Fiscal and
Calendar
Years

Short-Year
Returns

Use screen 1 to complete the corporation name and address section of Form 1120S.
For state purposes only, if the corporation has an alternate address (such as a P.O.
box), you can enter that address on screen 2, in the Address Line 2 field at the bottom
of the screen. (Access screen 2 from the States tab, or enter 2 in the selector field and
press ENTER.)

The program uses the calendar year as the default period for all corporation returns; no
date entries are required on screen 1 for a December 31 tax year end.

The program adjusts calculations for depreciation and for gains and

N OTES losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53—week year, see “Electing a
52-53-Week Year (Initial Return)” on page 44.

If the S corporation uses a fiscal year (where the year begins in the current calendar
year and ends in the next), specify the beginning and ending dates in the If not calen-
dar year section of screen 1.

An entity may have to file a short-year return if the entity is changing accounting peri-
ods with IRS approval (Form 3115), or if this is its first or last year in business and the
tax year is not a full year.

In the past, short-year return election information and certain other elections made by
S corporations were entered in Drake on the ELEC screen. Starting this year, short-
year return election information and 52-53-week tax year information is entered on
the YEAR screen, available on the Miscellaneous tab of the Data Entry Menu or
from a Year link on screen 1. (Certain other elections are still made using the ELEC
screen.)

To enter short-year information:

1. Enter short-year dates on screen 1 in the Fiscal year begins and Fiscal year ends,
fields, even if the firm uses the calendar year for full-year returns. (These dates
will appear on the top of the federal form.)

2. Click the Year link to open the Year screen.

3. Make your short-year selection from the Other short-year election reason drop
list. Your explanation will be displayed at the top of the first page of the tax return.
If you do not select an explanation, an EF Message will be generated with the
return, and the return cannot be e-filed
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4. If you selected “General Explanation” from the Other short-year reason drop
list, type details on the reasons for filing a short-year return in the new Explana-
tion text box.

For more information on short-year explanations, see IRS Pub.
4163.

N OTES The program may not correctly calculate depreciation, gains, or
losses for a short-year return. Depreciation for a short-year return
can be entered on screen 4562 and screens 6, 7, 8, and 9.

First-Year An S corporation filing a first-year return must use the fiscal year fields in the If not
Returns calendar year section of screen 1 if the date of election as an S corporation occurs
after the start of the tax year—that is, if the date entered on line A of the General
Information section of screen 1 comes after January 1, 2015.

In the Fiscal year begins field, enter the date of election as an S corporation. In the
Fiscal year ends field, enter the end of the calendar year (or the end of the fiscal year
if not using a calendar year).

Boxes A through |

Enter most information for boxes A through I (top of Form 1120S) on screen 1. Note
that boxes C (“M-3 attached”) and F (“Total assets™) are completed automatically by
the program based on data entered elsewhere. Other boxes are:

e Box A — S election effective date

* Box B — Business activity code (From screen 1, choose a code from the line B
drop list, or click in the line B field and press CTRL+SHIFT+S to search for a code)

* Box D — Employer Identification Number (EIN) (program uses setup data as
default)

* Box E — Date incorporated

¢ Item G — Indicates first year as S corporation and inclusion of Form 2553 with
return

* Item H — Check boxes for final return, name change, address change, amended
return, and S election termination or revocation

* [tem I — Number of shareholders during the year (completed automatically based
on the number of K-1s; number can be overridden on line I of screen 1.)

Enter accounting method at the bottom of screen 1.

N OTES The Client information fields at the bottom of screen 1 are for
reports only and not included in the e-file record.

Income and Deductions

Income and deductions are entered primarily on the INC (Income) and DED (Deduc-
tions) screens.
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Gross Receipts

Enter gross receipts or sales (Form 11208, line 1a) and returns and allowances (line
1b) on the INC screen.

The program calculates gross receipts or sales after returns and allowances based on
gross receipts, sales, and any direct entry on line 1b.

The IRS does not require a detail (CTRL+W) worksheet for gross
receipts; therefore, if you are using the trial balance import feature, do
N OTE not include a detail worksheet for this line—or for any other line that
does not require a detail worksheet. For more on the trial balance
worksheet, see “Importing Trial Balance Information” on page 49.

Cost of Goods Sold (Form 1125-A)

For cost of goods sold (COGS), complete screen A (Form 1125-A, Cost of Goods
Sold).

On screen A, items 9a through 9f are direct-entry fields and follow the
N OTE format of IRS Form 1125-A. For more information on completing
these fields, press F1 or consult the IRS instructions.

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories™). Note that the Inventories fields on screen L (Assets,
Liabilities and Equity) are overrides. Anything entered there overrides the inventory
data that flows from screen A.

Line 5, Other Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
Costs  ous lines. In Drake, two fields on screen A are provided for line 5: one for other costs
excluding depreciation, and one for depreciation (Figure 1).

4  Additional section 2634 costs.............
Other costs - excluding depreciation

5  Depreciation......eeeeeees 4

T Inventory atend ofyear. ...

Figure 1: Other Costs and Depreciation

In the field on the Depreciation line, enter any depreciation that relates to the cost of
goods sold (unless the amount is flowing from the 4562 Detail screen with COGS
selected from the For drop list). (Note that this field on screen A is an override field;
an entry here overrides the calculations from the 4562 screen.) Amounts entered in
this field automatically adjusts the total depreciation that is carried to page 1 of Form
1120S.
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Importing
Trial Balance
to Form
1125-A

Entries in the Other costs - excluding depreciation ficld opens a Detail Worksheet.
The depreciation amount is included on the statement for other costs and should not be
included in this worksheet.

N OTE Line 14b on the DED screen is for Form 4562 depreciation that is not

entered on screen A or elsewhere on the return.

If using the trial balance import feature (see “Importing Trial Balance Information” on
page 49), enter depreciation amounts directly into the appropriate fields on the trial
balance worksheet, not into the fields in data entry. When the trial balance is imported,
the COGS depreciation expense amount flows directly to the appropriate line of Form
1125-A and is calculated accordingly.

Ordinary Gains and Losses

The amount on line 4 (“Net gain (loss) from Form 4797, Part Il, line 17”’) of Form
1120S flows from Form 4797. Amounts can also flow from screen 4562, but only if
that screen shows assets sold and property type.

Other Income (Loss)

Enter all amounts for line 5, “Other income (loss),” on the INC screen. INC screen
data is displayed on attached statements in View mode.

Amounts from the following screens also flow automatically to line 5:

* 6478 (Form 6478, Biofuel Fuels Credit)
e 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields on the INC screen include:

*  Amount of credit for tax on fuels
¢ Interest income on receivables

* Recoveries of bad debts

* Section 481 adjustments

¢ State tax refund

* Income from insurance proceeds

To enter income or loss from a partnership, estate, or trust, use screen K1P or K1F.
(Click the screen links on the INC screen or access them from the first Other Forms
tab).

To enter additional sources of income not shown, use the Other Income (itemize)
field on the INC screen. (An entry in this field creates a Detail Worksheet.)
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Compensation and Wages

Enter shareholder compensation and employee wages on the DED screen. Drake has
two fields each for officer compensation and employee salaries/wages: one for non-

Credit
Adjustments

shareholders, and one for shareholders.

The Salaries and wages to non-shareholders field is an adjust-
ment field. An amount entered here is combined with any amount

N OTES entered in the Labor hired field on screen F.

The shareholder fields are used for calculating section 179 income
limitations; see the WK_S179L worksheet in View mode.

A credit adjustment is made for the following forms:

*  Form 5884, Work Opportunity Credit

* Form 8844, Empowerment Zone and Renewal Community Employment Credit

¢ Form 8845, Indian Employment Credit

The adjustment is indicated on Form 1120S with the ATT SSW literal (Figure 2).
Actual adjustments are shown on the ATT SSW worksheet in View mode.

Total income (loss). Add lines 3throughS  « v v v v 0 v 0 v i v i s v e i s

e T i e, e
Gitfier income (loss)i&ee insticéfons - attach statement] "~ "7 0 =7 =L stibement 41 -

——

14,855,158

Repairsand maimenance  « + » » o o 0 v 0 0 0 b n a s s e 0 0w e e s a T

-

Baddebis  « v v o v v e e e e e e e e e e e e e e e e e e e e e

g -
6

7  Compensafion ofoficers (seeinstructions - attach Form 1125-E)  + « « » =« « « T

&  Salaries and wages (lesz employment credits)  « « - 0 - 0 0 s e s e e e e e -

9 T 9
0

10

120,587
101,73%

D —
6
7
&

M DA gan: o o, ﬁ_,w'-‘-ﬁ—-""‘ Al ,_Q-‘““"‘- st g, T L

Figure 2: ATT SSW literal on Form 1120S

Compensation of Officers (Form 1125-E)

Officer
Information

Use screen E to enter officer information and compensation amounts. Press PAGE
DOWN to enter additional officers. Screen E totals are calculated and carried to line 7

of Form 1120S.

The total of officer compensation can be entered in the Officer Compensation over-
ride field on the DED screen (generally used when Form 1125-E is not required). An
entry in that field overrides any calculations from screen E, changing lines 12 and 27

of the 1120S but not Form 1125-E.

For privacy reasons, you can truncate SSNs on Form 1125-E by enter-

ing only the last four digits of the officers’ SSNs in the ID number field.

To do so, enter the first five digits of the SSN as “0”s, and then enter the
N OTES final four digits of the SSN. Press CTRL+F to “force” the program to

accept the number.

For example, enter SSN 123-45-6789 as 000 -

CTRL+F.

00-6789. Press

Tax Year 2015
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Screen E
Check Boxes

Ownership &
Participation

Screen E has two check boxes: Signs return, and Books in care of. Mark the applica-
ble box on the screen that identifies the officer who either signs the federal or state
paper returns, or is the contact person for the books.

NEW FOR If you mark the Signs return check on box screen E, that officer’s infor-

mation flows to the PIN screen automatically, eliminating the need to re-

20-| 5 enter that information. You would still have to enter PINs for the ERO

and the officer and signature date on the PIN screen for e-file purposes.

The Ownership and Participation fields on screen E are required. Fields are as fol-
lows:

* Total — Enter the officer’s ownership percentage.

* Common — Enter the percentage of common stock owned by the officer.

* Preferred — Enter the percentage of preferred stock owned by the officer.
¢ Time — Enter the percentage of time the officer devotes to the corporation.

Enter percentage amounts in whole numbers. For example, enter 40 for 40%.

Repairs and Maintenance

Bad Debts

Rents

Enter repair and maintenance costs on the DED screen. An amount entered there is
combined with the amount, if any, entered in the Repairs and maintenance field on
screen F.

Use the Bad debts field on the DED screen to enter the total debts that became worth-
less in whole or in part during the year, but only to the extent that such debts related to
a trade or business activity.

Enter deductible non-business bad debts as a short-term capital

N OTES loss on screen 8949 (Sales and Other Disposition of Assets).

Cash-method S corporations cannot take a bad debt as a deduc-
tion unless the amount was previously included in income.

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the corporation rented or leased a vehicle, enter the total annual rent or
lease expense incurred in the trade or business activity of the entity, and then complete
Part V of the 4562 (screens 8 and 9).

The Rents field is an adjustment field. An amount entered here is

N OTE combined with the amount, if any, entered in the Rent fields on

screen F.

10
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Taxes and Licenses

Enter tax and license amounts on the DED screen. Amounts are combined and the
sum generated on Form 11208, line 12 (“Taxes and licenses”). Note that credit from
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain
Employee Tips) should be entered on screen 8846, which is accessible via a link from
the DED screen. These amounts also appear on the “Taxes and Licenses Attachment,”
referred to on line 12 with the printed “ATT_STL” reference. (Figure 3.)

4 - R SR Msnmdnatod™ L. T T i e A T T
10 Baddebts . . . . . . . .. . .. o o 10

11 Rents . . . . .. Lo . 11

12  Taxesandlicenses . . . . . . ... ..o . 12 11,457
13 Imterest . 0L oL 0oL oo . 13

14 Deprecistion not claimed on Form 1125-A or elsewhere on return (attach Form 4582) 14

15  Depletion (Do not deduct eil and gas depletion.) . . . . . . . . . ..o oL 15
B T S N g S =Y

Figure 3: Notification on line 12 of the 1120S return that the
Taxes and Licenses attachment has been produced with the return.

To keep the notification from appearing on line 12 of the return, go to the PRNT
screen and select Suppress printing of form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes)
screen are carried to the tax computation (ATT TAX) worksheet. The state tax
amount carried from the ES screen may differ depending on which method of
accounting (cash or accrual) is used.

Interest
Using the 11208 instruction guidelines, enter interest expense on the DED screen.
Note that the Interest expense field is an adjustment field. Any amount entered here
is combined with the amount, if any, entered in the Interest fields on screen F.
Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list to associ-
ate the depreciable item with the correct form or activity. Data from the 4562 screens
is calculated and carried to Form 11208 and/or to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake, see the Drake
Software User’s Manual: Tax Year 2015.

Line 14, Line 14 of Form 11208 is reserved for depreciation that (1) is from Form 4562, and
Depreciation (2) is not claimed on Form 1125-A or elsewhere. While the program pulls data from
the 4562 screen for this line, it also provides field 14b on the DED screen specifically
for depreciation that is claimed elsewhere.

Both lines 14a and 14b on the DED screen are adjustment fields.

* Line 14a — See field-level help for further instructions and information on
how this field ties in to Form 4562.

Tax Year 2015 11
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Depletion

Advertising

* Line 14b — Drake Software recommends entering depreciation on the 4562
screen, and then selecting COGS from the For drop list at the top of the
screen. You can also use screen A (rather than the DED screen) to enter depre-
ciation claimed on Form 1125-A. An entry on screen A adjusts any entry on
line 14b of the DED screen and is calculated into the total deductions for page
1 of Form 1120S. If there is an entry on line 14b of the DED screen but not on
screen A, only the line 14b amount will be calculated into total deductions.

Enter depletion amounts on the DED screen. If the corporation claims a deduction for
timber depletion, complete and attach Form T, Forest Activities Schedules. (Attach as
PDF to e-filed returns. See “The PDF Attachment Process” on page 46.) Do not
deduct depletion for oil and gas properties. (Each shareholder should figure depletion
on these properties under section 613A(c) (11).)

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

Enter pension and profit-sharing expenses on the DED screen. Press F1 for informa-

tion on what expenses to enter. The software reduces the expense based on the credit

amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup

Costs. Note that this is an adjustment field; the software uses any amount entered here
to adjust the amount flowing from Schedule F to the 1120S.

Employee Benefits Program

Enter on the DED screen amounts for fringe benefits paid or incurred on behalf of

employees owning 2% or less of the corporation’s stock. Do not include with these
amounts anything that is an incidental part of a pension, profit-sharing, etc., plan or
amounts reported elsewhere on the return.

Report amounts paid on behalf of more than 2% shareholders on line 7 (“Officer com-
pensation”) or 8 (“Salaries and wages”), whichever applies. A shareholder is consid-
ered to own more than 2% of the corporation’s stock if that person owns, on any day
during the tax year, more than 2% of the outstanding stock of the corporation or stock
possessing more than 2% of the combined voting power of all stock of the corpora-
tion.

Note that the field for line 17 is an adjustment field. An amount entered in here adjusts
the amount flowing to Form 1120S from Schedule F, line 17.

Other Deductions

Enter all other deductions on the DED screen. Drake incorporates the total into line
19, “Other deductions,” on Form 1120S.

12
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The following deductions, credits, adjustments, and exclusions also flow to line 19:

*  Amortization from Form 4562
* Credit adjustment from Form 8820, Orphan Drug Credit
¢ Exclusion from Form 8873, Extraterritorial Income Exclusion

* Credit from Form 8941, Credit for Small Employer Health Insurance Premiums

Tax and Payments

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S.
Note that some fields are overrides. Press F1 to view more information on a field.

Net Passive Income

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S cor-
poration if it was formerly a “C” corporation or if it engaged in a tax-free reorganiza-
tion with a “C” corporation.

To determine if the corporation must pay the tax, complete the worksheet fields on the
lower half of screen 4. If completing the IRS worksheet, enter the worksheet results on
screen 4. Enter LIFO recapture directly on screen 4.

N OTE To force the line 22a worksheet to be printed, select the applicable
box on screen 4.

Schedule D

Use screen 8949 to enter capital gains and losses. The net gain from screen 8949 is
carried to lines 7 and 8 of Form 1120S, page 3, Schedule K. Use screen 8949 to enter
data for Parts I and II of Schedule D (Form 1120S), Capital Gains and Losses and
Built-in Gains. Use the D2 screen for Part 111, “Built-in Gains,” of Schedule D (Form
11208S). For information on using the 8949 import feature in Drake, see “Form 8949
Imports” in Chapter 5 of the Drake Software User s Manual: Tax Year 2015.

Estimated Taxes

The 1120S does not have a federal estimated tax voucher. Estimated tax payments are
required only in certain situations. An S corporation must make electronic deposits of
employment, excise, and corporate income taxes using the Electronic Federal Tax
Payments System (EFTPS).

Most states do not allow estimate payments outside of the EFTPS

N OTE system. View the field help for the e-file check box in the e-file/Elec-
tronic Fund Withdrawal section of screen ES for a list of states that
allow e-filed payments.

ES Screen The ES screen (available from the Miscellaneous tab or from a link on screen 4) pro-
vides a place to enter federal and state estimated taxes paid in 2015. If the return was

Tax Year 2015 13



Tax and Payments Drake Software Manual Supplement: 11208

updated in Drake from 2014, this information is carried over. Note that this informa-
tion will be overridden by any entry in the Current-year estimated tax payments
field on screen 4.

Use the ES screen for 2016 estimated payments. Future year amounts appear on the
ES SUM worksheet generated with the return. (You have to enter amounts in the
“voucher” fields in the “Estimate amt” column to get the ES SUM worksheet.) To
enter the amount to be credited, use the Amount of overpayment to apply to 2016
field. Note that this information will be overridden by any entry in the Amount to be
credited to next year’s estimated tax ficld on screen 4.

The ES screen also provides a way to e-file state estimated tax vouchers and pay-
ments, which is required in some states. For estimated taxes from multiple states or
cities, press PAGE DOWN and go to a new ES screen.

For details on using the enhanced ES screen for filing federal estimated taxes, and on
e-filing and paying state estimated taxes, see “Estimated Taxes,” in Chapter 5 of the
Drake Software User’s Manual: Tax Year 2015.

Payments with Extensions

To make a payment with an extension request, enter the amount being paid in the
Amount paid with extension ficld at the bottom of the 7004 screen (available from
the first Other Forms tab or from a link on screen 4). If an extension was previously
requested and a payment was made then, enter the amount paid on screen 4, line 23b.

For electronic payments on extensions, the program produces Form 8878-A, the IRS
e-file Signature Authorization for Form 7004.

Tax Paid on Fuels

Use screen 4136 to enter information for Form 4136, Credit for Federal Tax Paid on
Fuels. Note that this screen consists of two screens, with lines 1 through 8f on the first
screen. Press PAGE UP or PAGE DOWN to go from screen to screen.

Underpayment of Estimated Tax

For underpayment of estimated tax, complete all applicable fields on screen 2220.
(Note that this screen also consists of two screens.)

NEW FOR The program now produces Worksheet for the Underpayment of Esti-
20'| 5 mated Tax by Corporations (WK_2220) to explain the calculations for
the 2220 penalty.
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Late-Filing Penalty

Drake does not calculate a late-filing penalty. You can choose to enter a late-filing
penalty on screen 4, line 24, “Estimated tax penalty.”

If you enter a late-filing penalty on screen 4, line 24, then

| M PO RTANT Form 2220, Underpayment of Estimated Tax, will not be

included in the e-file transmission.

Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporation’s refund to be directly deposited.
To complete this form in Drake, use the DD screen (available from the General tab of
the Data Entry Menu).

Federal Account and State (if same as Federal)

Deposit selection: Federal selection............ | - State/city selection.................... x

Mame of financial institution RTH Account number Type of account
| | [~ Checking [~ Savings
[~ Checking [~ Bavings

Repeat Account Information | |

Figure 4: Federal section of DD screen (also 8050 screen)
When filling out screen DD (Figure 4):

* [fthe federal refund is to go to the account listed, select Yes for the Federal
Account selection; otherwise, select No. (If neither is selected, the program will
use the default selection — Yes.)

e [fastate refund is to go to the account listed, select the state abbreviation from the
State/city selection drop list.

* Enter the name of the financial institution, the routing number (RTN), the account
number, and the type of account (Checking or Savings).

* Re-enter the RTN, account number and type of account to verify.

If receiving refunds from more than one state tax authority, use the State Account sec-
tions on the DD screen to indicate where other state refunds should be deposited.

International ACH Transactions

In 2009, state taxing agencies added foreign account questions to their forms to com-
ply with NACHA rules regarding International ACH transactions (IAT); however,
processing IAT is not yet supported by any federal or state tax authority. If you were to
indicate that the account was outside the U.S., the state tax authority would automati-
cally ignore the account information and either issue a refund via paper check, or con-
tact the corporation requesting the payment of a balance due via check or domestic
bank account. If you indicate that an account is located outside of the U.S., Drake
Software generates an EF message instructing you to choose an account located in the
U.S.

Tax Year 2015
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For more information, see Screen Help on the DD screen and PMT screen.

Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due
for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides

By default, the program indicates that the entire balance due (the “Amount owed” line
of Form 11208S) is to be withdrawn on the return due date. To indicate otherwise, com-
plete the Requested payment date override field of the PMT screen for the applica-

ble payment.

If the return is e-filed on or before the due date, the requested payment date cannot be
later than the due date. If the return is transmitted after the due date, the requested pay-
ment date cannot be later than the current date.

Required Information

A Withdrawal selection (item # 1 in Figure 5) is required if the program is to direct
federal and state tax authorities to withdraw funds from the taxpayer’s account.

F- _»\;\.C-COI\.LIht;?::]”."-"/__'-_‘""“'_“-“"""""" e TN e e T, e e ! W T e L
Federal Account and State (if same as Federal)

mhdrawalselecﬁon: Federal selection....... |Y ﬂ Statelcity selection............. |NC' j)

MName of financial institution RTN Account number Type of account
|First Bank loooio0010 123458789 v Checking [ Savings
Repeat Account Information /000100010 [123456789 ¥ Checking [ Savings

Federal: Federal payment amount...... = Requested payment date....= Daytime phone number..=

3 Payment is for.......ccoeeees ¥ 112058 [ 7004 [ Amended 11208) !
State: State payment amount......... = Requested payment date....= Daytime phone number..=

- B e iy ‘".ﬂ"""ﬁ"““‘ e — .,a_"’"“-'--—.»"‘"‘" B L S

Figure 5: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, routing number (RTN), account number, and
account type are required. As is the case with the DD screen, the RTN, Account num-
ber, and Type of account data must be entered twice (item # 2 in Figure 5).

Finally, the PMT screen must indicate the return to which the payment data applies
(item # 3 in Figure 5). Put a check mark in the box of the applicable return type.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or
state taxes. To have state amounts withdrawn from an account other than the account

16 Tax Year 2015



Drake Software Manual Supplement: 11208 Filing an Extension

indicated for federal payments, complete the fields in the State Account sections of
the PMT screen.

N OTE Neither the federal nor the state balance due can be paid from more

than one account.

Filing an Extension

Calendar year returns are due on March 15, 2016. By filing Form 7004, an S corpora-
tion can extend the deadline six months to September 15. Fiscal year returns are due
on the 15th day of the third month after the end of their tax year. Form 7004 extends
the deadline six months.

For electronic payments on extensions, the program produces Form 8878-A, the IRS
e-file Signature Authorization for Form 7004.

To file an 1120S extension, use either of the following options:

*  Go to the 7004 screen in Drake (available from the first Other Forms tab of the
Data Entry Menu) and select Generate an extension. Complete any other appli-
cable fields on the screen.

* Go to the PRNT screen and select Prepare Form 7004 based on screen 1 data.

Signing the Return

Electronic PIN signatures are required to e-file returns. All fields on the PIN screen
must be completed to e-file a return, including the title and signature (name) of the
officer signing the return. (See “New for 2015” on page 18.)

An 11208 return must be signed and dated by one of the following individuals:

* The corporation’s president, vice president, treasurer, assistant treasurer, or chief
accounting officer

* Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required
information on the PIN screen. If it is prepared by an employee or officer of the cor-
poration, open screen 1 and select NONE in the Firm # and Preparer # fields.

To have the preparer’s name and address information displayed on the printed return:

* If the return preparer and ERO (entered in Setup > ERO) are the same:

— Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.

— Complete the PIN screen for the return.
* If the return preparer and ERO are not the same:

— Go to the PRNT screen for the return and complete the field labeled PIN for
preparer’s alternative electronic signature. The PIN entered should match

Tax Year 2015
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the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

Setup > ERO must be completed for e-file. For information on how to

N OTE complete this setup window, see Drake Software User’s Manual: Tax
Year 2015. See the IRS instructions for further details on signature
requirements.

NEW FOR If you mark the Signs return check on box screen E, that officer’s infor-
mation flows to the PIN screen automatically, eliminating the need to re-

20] 5 enter that information. You would still have to enter PINs for the ERO
and the officer and signature date on the PIN screen for e-file purposes.

Amending a Return

Amended 1120S can be e-filed using Drake Software.

When you amend a return in Drake, the amended information
replaces the original in the data file. Before amending a return,

CAUT' ON you should archive the original to avoid losing previously sub-
mitted data. For more information on archiving returns, see

“Archive Manager” in Chapter 6, “Return Results,” of the Drake
Software User’s Manual: Tax Year 2015.

To file an amended 11208 return:
1. Go to screen 1 and select Amended return in section H.

2. Make changes as applicable to forms and schedules.
3. Go to the EF screen and mark the Amended 11208 check box on the left side of

the screen.
Type AMD or X 4. Go to screen X (available from the Miscellaneous tab of the Data Entry Menu)
;,g%’gﬁ (fg’r‘zgfr and list the changes that have been made, along with an explanation for each
ENTER. change. Use a different X screen for each line of the 1120S. Press PAGE DOWN to

open a neéw X screen.

If amending just the K-1s, go to each applicable K1 screen, select Amended K1, and
make needed changes.

When amending an 1120S return, all K-1s are amended and the

N OTE “Amended K-1” box on the return marked by default. To override this
default, go to the PRNT screen and mark Do NOT check amended
box on Sch. K-1. (See Figure 11 on page 26.)

Additional Information

This section covers Schedule B (Other Information), state-specific information, and
some program overrides.
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Schedule B

Select B1 from the
Data Entry Menu
or enter B in the
selector field and
press ENTER.

Enter the accounting method, principal business activity, and product or service on
screen 1. This information flows to lines 1 and 2 of Schedule B.

Use screen B (accessible from the General tab of the Data Entry Menu) to answer
questions 3 through 13b of Schedule B.

If the answer to question 3 is “Yes,” complete screen B1 (press PAGE DOWN from
screen B). If the S corporation owned, directly, 20% or more, or owned directly or
indirectly 50% or more of the total stock issued and outstanding of any foreign or
domestic corporation, click the B4A Screen link on screen B to enter information
about the domestic or foreign corporation owned. (You can enter information for up to
10 corporations per B4A screen; to add more, press CTRL+PAGE DOWN.)

If the S corporation owned, directly, 20% or more, or owned, directly or indirectly,
50% or more in the profit, loss, or capital in any foreign or domestic partnership
(including an entity treated as a partnership), or in the beneficial interest in a trust,
click the B4B Screen link on screen B to enter information about the domestic part-
nership owned. (You can enter information for up to 10 partnerships per B4B screen;
to add more, press CTRL+PAGE DOWN.)

State-specific Information

Resident
State

Contact
Information

Other States

The program automatically generates a return for the corporation’s resident state. Use
screen 2 to enter company information as it should appear on the state return.

The company information fields on screen 2 apply for the resident

N OTES state only.

Click the screen 2 link from the States tab or enter 2 in the selector
field and press ENTER.

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

If certain contact information required for state purposes is different from that entered
on screen 1, use screen 2 for the alternative data for any of the following entities:

* Registered office
* Principal place of business

e  “Books in care of” information

Screen 2 also has fields for the name, title, mailing address, e-mail address, ID num-
ber, and telephone number of the S corporation’s contact person.

Data for other states must be entered manually in state data entry. To access state data
entry, select the States tab from the Data Entry Menu and choose a state, or enter the
two-letter state code in the selector field and press ENTER.

Tax Year 2015
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Multi-State Enter sales, payroll, and property factors on the APPT Multi-State Apportionment
. Appor- screen (Figure 6). This screen provides one central location for entering all state
tionment  ;pportionment information instead of having to open each needed state’s screen.

In addition to making data input faster and easier, this feature provides two work-
sheets: a summary worksheet (SA-SUM~) that can be used for verifying input, and a
reconciliation worksheet (SA-REC) that ties the total of the state amounts to the fed-
eral return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drake16
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake14 to Drakel5.

@ales | Payroll | Property | Additional F'ronertD
A&;‘ Screen links

State Apportionment - Sales Factor

State Selection Required field @c j ]yj j ]CI %])
Zero Apportionment - No Activity in State ™ ™ v
Sales
Outside state to inside stata | 123125 | se3z1 |
Within state to within staf] State drop lists | 112233 | 10203 | Zero
Within state to U.5. Govelmrrerme—= | | r apportionment
Throwback (nontaxable jurisdiction).................... | | r

Returns and Allowances
Outside state to inside state.......... |

Within state to within state
xﬁ\ﬂ?‘f_ithin state tg U..ﬁfﬂ“'f_m”f_r} .......... “‘L. i ey |\ - ,
Figure 6: APPT Multi-State Apportionment screens

Mark the Zero Apportionment check box (Figure 6) to add a state

N OTE but not include any apportionment data. This will include the state
on the apportionment summary worksheet (SA-SUM~), available
through View mode.
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APPT Screens

The APPT screen is opened to the Sales tab. Links at the top of this screen take you to
the Payroll, Property, and Additional Property tabs for each state selected
(Figure 6 on page 20). These screens and their uses are listed in Table 1:

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors; select additional apportionment factors from
drop lists

Additional Property Select additional apportionment factors from drop lists

The Ending amount entered on the Property and Addition Property

N OTE screens in Drake15 will become the Beginning amount for property

on the APPT screen when the client’s return is updated next year in
Drake16.

You may enter up to four states on one APPT screen. If you need more than four
states, press PAGE DOWN for a new APPT screen. The same state can be entered more
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a
reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any
information to be entered, no information will flow to that state’s return.

Schedule K: Shareholders’ Pro Rata Share Items

Navigation

Screen K, which consists of five “tabbed” screens, can be used to enter data for
Schedule K, Shareholders’ Pro Rata Share Items. Note that many K fields are adjust-
ment fields. Press F1 inside a field to see what amounts are adjusted from elsewhere in
the program.

To promote greater accuracy in allocating Schedule K data to the individual share-
holder’s Schedule K-1, and to improve the detailed statements provided to sharehold-
ers on their K-1s, Drake has made several enhancements and additions:

* Screen K is now a “tabbed” screen, with separate tabs for data entry of Income,
Deductions, Credits, AMT and Basis, and Other Information (item #1 in

Tax Year 2015
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Figure 7 on page 22). Click the tabs at the top of the K screen or press PAGE Up

and PAGE DOWN to navigate among the K screens.

( Income Deductions Credits AT and Basis OtherlnformatioiD

Income {Loss)

7 Met rental real estate income (loss)

Schedule K - Shareholders' Pro Rata Share of Income (Loss)

3c  Other rentalincome (loss).

S

Interest income

5a Total ordinary dividends
5b Qualified dividends

6  Royaltyincome
T Met short-term capital gain (loss)

2 Form 8825

3¢ RENT Screen
4 +- 12345
5a +- 321
5p +-

6 *- 1212

Sch D Screen

8a Metlong-term capital gain (loss). Ba
8b Collectibles (28%) gain (l0ss). 8b *-
8c  Use screen 1250 gc 1250 Screen
9  Netsection 1231 gain (loss). = 9 Form 4797
ﬂﬁ_ Other Income \2..} \
A Other portfolio A -
B Involuntary conversions B +-
C 1256 contracts & straddles [o Form 6781
D MWining exploration costs recapture D *-
E Otherincome (loss)
Recovery of tax benefititems (section 111).
Gambling gains (losses) subject to section 165(d) limitations
Dispostition of interestin oil, gas, geothermal, or other mineral properties
Deferred cancellation of debt income under section 108(i)
Gain from sale of QSB stock eligible for section 1202 exlusion...
\ Gain from replacement stock purchased by the corporation _/

e PR T v _b_‘:_?_‘,“ ST T Y TRr— Y

Figure 7: Screen K is now tabbed (item #1) with more “other” items (item #2)

Each of the tabs includes more “Other” items, such as “Other” income, “Other”
deductions, “Other” credits (see item #2 in Figure 7), allowing a more detailed
supplemental K-1 statement than ever before (Figure 8 on page 23).

22
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Schedule K-1 Supplemental Information 2015
‘Shareholders name ‘Shamhotiers ID Number
Dante Alighieri 123-12-3123
Name of 3 Corporaton 5 Corporatbe’s EIN
Ess Bee Ess 40-0001120
Form 11208 Schedule K-1 - Line 10
Code Description Amount
E— Other Income (Loss) — 8z7
Recovery of Tax Benefit Items (Section 111) 195
Gambling Gains Subject to Section 165 (d) 351
Disposition of Interest in Mineral Properties 51
Cancellation of Debt Income Under Section 108 (1) 23
Gain from Sale of Q8B Stock for Section 1202 107
Total 827
Form 11208 Schedule K-1 - Line 12
Code Description Amount
T Deductions—Royalty Income — 110
Advertising 19
Auto 7
Maintenance 54
5 Other Deductiocns 1,074
Amounts Paid By Corp Allowed as Itemized Deductions 195
Soil and Water Conservation Expenditures 702
Endangered Species Recovery Expenditures 177

Total 1,184
Form 11205 Schedule K-1 - ILine 13
Code Description Amount

T Other Credits 28
Unused Investment Credit for Advanced Energy 1
Unused Investment Credit for Rehab\Energy
8820 Orphan Drug Credit

U ﬁm‘,.-—k.\_‘_wt wﬁ*,“___’.‘w___h“_’f‘unm&q-

=1 0}
[SJERTe]

Figure 8: More detailed statements with Schedule K “Other” items

* Information on foreign transactions is now entered on a separate KFT screen,
accessible from the General tab of the Data Entry Menu or from a link on the
Credits tab of screen K. Through the KFT screen, you can now report multiple
foreign transactions. (Press PAGE DOWN for a new KFT screen.)

¢ Drake now generates a “Foreign Transaction Statement,” shown as “WK_FTRS,”
(Figure 9), listing all the foreign transactions for an S corporation. A separate
“K-1 Foreign Transaction Statement” (K1 _FTRS) is also generated, reporting
these foreign transactions for the individual shareholder.

R A (P R e
_1125E
_WK_FTRS™

L 11205K1

Ll K1ATT

(| K1 FTRS™D

. K1_gas~

L K1_san3

L T1205K_1

| KI_ATT

_ FIFTRS" >

. KI_862%5~

L K1_san3

L T1205K_1
| KI_ATT
_KI_FTRS™

_ Ki_gaz
SRR

m

I T £ R
TTTIIT1T

Figure 9: New Foreign Transaction statements
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Because charitable contributions are separately stated to the share-
holders, there is no “Charitable Contributions” line on the 1120S

N OTE return. Charitable contribution information belongs instead on the
Schedule K. Enter charitable contributions on the Deductions tab of
screen K, on line 12a - Contributions. Any contribution limitation is

made at the shareholder level.

Schedule K - Business Activities Statement

A Business Activities Statement (screen BAS) breaks down an S corporation’s Sched-
ule K items by business activity (Figure 10). A K-1 statement by business activity is

also provided.

Business Activity Statement
2015
(Keep for your records)
TUb-Comoration feme =
Ess Bee Ess Corp 40-0001120
Shareh older Name SEMEIN
Dante Alighieri 123-12-3123
ACTIVITY NAME(S)/Activity 1 - Restaurant )
Activity 2 - Gift Shop
Activity 3 - Museum \
LINE REFERENCES
1 2 3 Tnallocated Sch K1 Total
~ | Ordinary Bus iness Income j
[Loss) 1,945 1,753 1,611 2,327,157 2,332,470
PR " ——
T HHetRentstRestExtstetncome SeeKl s
{Loss)
3. | Cther Net Rental Income (Loss ) 156 390 123 (669)
4. | Interes t Income 1235 335 88 1,401 1,549
5a. | Ordinary Dividends 15 547 35 {550} 51
5b. | Qualified Dividends
! E———— N ﬂ____...-m.-.—u_\_ T S —e—— T NP S — D T
a's

Figure 10: Business Activities Statement

Schedule K-1 for 1120S (Shareholder Information)

Use the K1 screen to enter data for Schedule K-1, Shareholder’s Share of Income,
Deductions, Credits, etc.

The program calculates percentage ownership based on the number

N OTE of shares owned. (This amount can be overridden on line F of the K1
screen, using the Shareholder’s % of stock ownership field; how-

ever, this not recommended.)

Rounding Shareholder

Mark the check box on screen K1 to select which should be the “rounding” share-
holder. That shareholder will be listed last on the list of shareholders and will be the
one who receives any balancing amount on Schedule K-1 when the return is calcu-

lated.
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If you do not make a selection, the program designates as the rounding shareholder the
last shareholder you entered. If you select more than one rounding shareholder, the
program generates a Return Note informing you that you’ve chosen more than one
and that the first shareholder you entered will be used as the rounding shareholder, and
lists all those you have included as rounding shareholders.

Ownership Changes

Printed Data

Ownership changes are entered on the OWN screen, which is accessible through the
OWN Screen link on line F of the K1 screen or from the General tab of the Data
Entry Menu. To use the OWN screen:

* Enter the date of ownership change at the top of the screen.

* Select the applicable shareholder from the Shareholder’s ID Number and Name
drop list in the Change in Shares section. (The drop list consists of the names and
ID numbers entered on the K1 screens and is updated automatically).

* Enter the change in ownership as a positive amount for an increase and a negative
amount for a decrease. (See field-level help for more information.)

* To enter additional ownership changes, press PAGE DOWN.

N OTE See FAQ item “P” in the program for more information on entering

ownership-change information.

A Summary of Stock Ownership worksheet (WK _SOWN) is generated, listing all
shareholders and the numbers of stocks owned along with the changes in ownership.
Because a shareholder’s percentage of ownership may change even if the share-
holder’s number of stocks owned does not, all shareholders are listed on the work-
sheet.

IRS K-1 Codes

A code sheet can follow the printing of each Form 1120S K-1 to help interpret the var-
ious codes used on Schedule K-1. In Drake, this is the 1120SK_1.PG3 sheet. To have
this sheet printed with all K-1 schedules, from the Home window of Drake, go to
Setup > Options > Form & Schedule Options tab and mark the Print Page 2 of
Schedule K-1... check box. The codes can also be printed for a specific return by
marking the applicable box on the PRNT screen, and are available from Tools >
Blank Forms.

Codes sheets are not displayed in View mode. If the 1120S K-1 is

N OTE selected for printing, it is printed first, followed by the statements per-

taining to that 1120S K-1. These are followed by the code sheets.

The generated Schedule K-1 may include asterisks with letter codes:

* An asterisk with a letter code indicates that multiple items have that code.

* Anasterisk at the bottom of a group indicates that there are more items than can fit
in the space provided for that group and that a statement is attached, or that the
statement is required (as in the case of “other” amounts).

Tax Year 2015
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Multiple Shareholders

For returns with a large number of shareholders, you have the option to deactivate cal-
culation and printing of the K-1s while working on the Form 1120S. This option,
which eases the process of reconciling the 11208, is available by going to the PRNT
screen and marking the box under K-1 Items to Suppress (Figure 11).

K-1ltems to Suppress

(¥ Suppress Sch K-1, K-1 letter, K-1ATT, and WK_SBAS D
I~ Do MNOT check amended box on Sch. K-1 (from screen 1)
I~ Suppress K1_DIST

Figure 11: Check box for suppressing K-1 items (located on PRNT screen)

When the return is ready to be filed, return to the PRNT screen and remove this check
mark before calculating the return.

Override Fields

It is not possible to override the calculations for a single shareholder. To override cal-
culated data, it is necessary to override the calculated amount on all K-1 schedules.

Shareholder overrides should not be done for an S cor-

| M PO RTANT poration except in certain circumstances, such as owner-

ship changes.

Foreign Addresses

K-1 Export

If the shareholder has a foreign address, enter Province/state, country, postal code
information on the Foreign address line of the Shareholder Name and Address
Information section (along with the street address and city in the Address and City
fields) of screen K1. Do not enter anything in the U.S. State or ZIP fields. Con-
versely, for a U.S. address, do not enter anything into the foreign address fields.

The Foreign fields are locked when a return is opened. Click in one

N OTE of the fields to unlock them throughout the return. To relock the

unused Foreign fields, close and then reopen the return.

Take the following steps to export a K-1 from an 11208 return into a 1040 return:

1. Ensure that K-1 data is entered in the 11208 and that the 1040 return has been cre-
ated. (The K18 screen in the 1040 does not have to be created beforehand.)

2. Inthe 11208 return, go to View mode.

3. Click K1 Export in the View toolbar. If any K-1s are not eligible to be exported,
that list appears. Click Next to continue; otherwise, the Export K1s window is
opened, containing a list of K-1s eligible for export.

4. All SSNs in the list are eligible for export. Remove the check mark from the box
to the left of any SSNs you do not wish to export.
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5. Click Export. The K-1 data will be displayed in the 1040 return in the program.

Basis information for individual shareholders should be entered in the

N OTE 1040 package in Drake; this information cannot be exported from the
1120S package to a 1040 return. Such an import would override lim-
itations and carryovers calculated in the 1040 program.

Supplemental Info

Two types of supplemental information can be added to Schedules K-1:

* Supplemental data for all K-1s in a return

* Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry
Menu, open screen K1G (Global Supplemental Information) and enter the informa-
tion in the Supplemental Information text box. This information will appear on all
printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1
screen and click the blue Supplemental Info link at the top of the window. In the
Supplemental Information Statement text box (Figure 12), enter information perti-
nent to this shareholder. When the return is printed, this information will appear on
only this shareholder’s K-1.

K1 Basis Wks Supplemental Info

K1S$ - K-1 Supplemental Information Statement

Enter global supplemental information for all K-1s on the K1G screen.

Enter specific information for a single K-1 here. This information is added to
the global supplemental information entered on the K1G screen.

pa—

i
The following information pertains to shareholder{ C. Carter:|)

. g ‘r,.._-l N \._"‘_‘“"-M_'-“H--.A-h-«.-_"."u“-‘-‘-"\ i,

Figure 12: In this example, the information entered on the K1S screen will appear
on only the K-1 of the shareholder with SSN or EIN of 010101010.

N OTE The letter “X” appearing after the taxpayer’s SSN, as it does in
Figure 12, denotes the rounding shareholder.

Domestic Production Activities

An S corporation does not take the deduction for Form 8903, Domestic Production
Activities Deduction. Because the deduction is subject to income limitations, this
information must be reported on shareholders’ individual returns. Shareholders use
the pass-through amounts to calculate their eligibility for the deduction.
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On the 8903 screen, if the Print K1-8903 for each shareholder box is not selected,
the amounts flow to the K-1, box 12, with codes Q and R. When this box is selected,
the information flows to attachment K-1 8903 (Figure 13) instead of box 12 on the
K-1. Attachment K1_8903 is referenced on a statement. Code P is printed on box 12
of Form K-1, which refers to domestic production activities information.

All F0|m3| Sets | EF | Federal | Workshests | Metes/Messages | MatthCarolina |

Figure 13: K1 8903 attachment

Review the screen-level help on screen 8903 and the 8903 instructions (accessible
through the Screen Help button on the 8903 screen) to determine when the K1 8903
in needed.

Line 11,“Income limitation,” of Form 8903 is not applicable for the
S corporation because the income limitation is calculated at the

N OT ES shareholder level.

“Form W-2 wages” (on the 8903 screen) refers to the corporation’s
W-2 wages paid that are applicable to the Domestic Production
Activities Deduction.

K-1 Cover Letters

Producing
Letters for
All Returns

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You
can set up the global option to produce K-1 cover letters for all returns containing K-1
schedules, or you can choose the option on a per-return basis.

To have the K-1 cover letters produced automatically with all applicable returns, from
the Home window of Drake, go to Setup > Options. Under the Optional Documents
tab, mark the box labeled Include K-1 letter with returns.

The signature on the return can be indicated in one of two ways:

* By completing the Signature and Title fields on the PIN screen

* By completing the Name and Title fields in the K1L screen (available on the
Miscellaneous tab). Entries here override entries on the PIN screen.
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L T205K_1 -
L K1_ATT
K1_8825~ L. ‘\
k1 sanz Form 8903 Shareholder: Dante Alighieri . P
e P Domestic Production Activities Deduction
K1_FTRS™ {Fev. Decemper 2010)
k1 Bass Deprtment of th Treszun SSN/EIN: 123-12-3123 Percentage: 15.78947 Attachment
Y 11EDSK 1 Themal Revenue Senvoe M Attachto yourtax retum. B See separateingtructions SequenceNo. 143
=1 ATT Name(z) s hown on etum [gentiyA g number
= Ess Bee Ess Corp 40-0001120
- Note. Do not complete column (a}, unless you have oil-related {a) (b)
= e A e 2ciTes I celumn (b), Oil-related production adivities Al activiies
K1 _BASS 1 Domestic production gross receipts (OPGR)  + + « v o v o v v v v o s 1 1,949
11205k 1 2 Allocable cost of goods sold. Ifyou are using the small business
K1LATT simplified overall method, Skp lines 2and3  « o oo 0o 2 191
LY K1_8825" 3 Enter deductions and losses allocableto DPGR (see instructions) . 3 53
] k1_8903 4 Ifyou are using the small business simplifed overall method, enter the
LY K1_FTRS™ amount ofcost ofgoods sold and other deductions or losses you
. F1_BASS ratablyapportionto DPGR. All cthers, skiplingd  « « v v o v v v v v s 4
.. ELEC 5 Addlines2through4 « ¢ ¢ ¢ ¢ v 0 ot i i i bbb e 5 244
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Producing Ifno default has been set to produce K-1 cover letters with all returns, you can take the
Letters for following steps to generate letters for a single return:

Single
Return 1. Open the return and go to screen K1L (accessible from the Miscellaneous tab of
the Data Entry Menu).
Enter K1L in 2. At the bottom of the screen, enter the name and title of the person who will be

selector field and

press ENTER signing the K-1 cover letter.

3. (optional) Mark Do not print entity information... at the bottom of the screen in
order to prevent the corporation’s name and address from appearing in the header
of the K-1 letter.

To have the corporation’s name and address included in the K-1 let-
N OTE ters, from the Home window go to Setup > Communications Editor

> Setup > Page Layout and select Use letterhead on letters. The

letterhead is derived from information entered on screen 1.

Once the required signing information has been entered, a K-1 cover letter will be
generated for each shareholder receiving a K-1.

Editing the As with other letters provided by the program, you can edit the text to suit your office
K-1 Letter nceds and style.

Review the following sections of the Drake Software User’s Manual.:
Tl P Tax Year 2015 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, “Installation & Setup”
- The “Letter Keywords” section of Appendix B, “Keywords”

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Communications Editor. The Client
Communications Editor is displayed.

2. From the icons on the toolbar, select Open > S Corporation > Sub S K-1 Cover
Letter to view the template of the S corporation K-1 letter.

g

Make any desired changes to the template.
4. Click Save.

For an amended return, the K-1 letter automatically refers to the

N OTE amended K-1. To edit the letter for an amended K-1, from the toolbar
select Open > S Corporation > Sub S K1 Amended and follow steps
3 and 4 of the previous procedure.

Shareholder’s Adjusted Basis Worksheet

Basis information for individual shareholders should be entered in the

N OTE 1040 package in Drake; this information cannot be exported from the
1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.

Use the Shareholder’s Adjusted Basis Worksheet (Basis Wks) to calculate a share-
holder's new basis after increases and decreases are made during the current year. The
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Enter K1 in
selector field and
press ENTER.

Increases
and
Decreases

Annual
Update of
Shareholder
Information

basis of S corporation stock is adjusted on an ongoing basis (unlike for a “C” corpora-
tion, where stock basis remains constant unless additional stock purchases are made or
stock is sold). A shareholder’s beginning basis in S corporation stock is the original
capital contribution.

The Basis WKks screen is accessible by clicking the Basis WKks tab at the top of the K1
screen for a shareholder (Figure 14). (Access the K1 screen from the General tab of
the Data Entry Menu.)

K1 Supplemental Info i
- I
Schedule K-1 - Shareholder's Share of Income, Credits, Deductions, etc. {
E
Shareholder Mame and Address Information 3
D 1D NUMBET. oo 123123123 Type.... = ]
T [ante Rlighieri
Care offFBOIDBA. ...t | A
Address. [1234 La Principale via !
4
e |Flcrence
U.5.: SEAE, ZIP. oo | > Resident siate k
Foreign:  Province/state, country, postal code.. |Iuscany |II ﬂ
Phone number ... 123-458-78380 j

R TIPS S W S SR S e LSt e S

Figure 14: K1 screen tab for accessing the Adjusted Basis Worksheet

Increases to basis can include additional stock purchases and capital contributions,
separately stated income (including tax-exempt income), and depletion in excess of
basis of property.

Decreases to basis can include distributions of cash or property to shareholders, sepa-
rately stated losses and deductions, nondeductible corporation expenses, and credit
adjustments.

When the program is updated to the next tax year, the end-of-year basis and share-
holder loan amounts are automatically updated to the beginning of the new year. Any
loss/deduction carryover is updated to the beginning of the year and its character
(ordinary loss, section 179 expense, charitable contributions, etc.) maintained. The
program also tracks the amount of debt applied to losses and the total amount of loss
carryforwards.

N OTE If a K1 screen is marked as final, none of the related screens for that

shareholder are updated for the next year.
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Schedule L: Balance Sheet Per Books

Schedule L is required if the corporation’s total receipts for the tax year or its total
assets at the end of the year are greater than $250,000.

To force the program to print Schedule L even if not required, mark

the Force-print Schedules L and M-1 box on screen L or on the
N OTES PRNT screen.

With the Trial Balance Import feature, you might not need to use

screen L at all. See “Importing Trial Balance Information” on

page 49.

Schedules L and M-2

Schedule L and Schedule M-2 reconciliation totals are displayed on screens L and M2
to facilitate reconciliation of the balance sheet (item #1 in Figure 15).

Schedule L - Balance Sheet
Note: Use the SCH2 screen for required detail on lines 6, 9, 18, 21, and 25. The amounts entered there flow to the appropriate lines when the return is calculated.

HOTE: The retained eamnings account can be automatic; however, it is also used as the balancing account. If an amount is entered, it is compared with the
computed amount. If no amount is entered, no checking is done, and the balance sheet is forced to balance by the program.

HOTE: Auto-balance can be turned off from the PRNT screen.

I¥ Farce-print Schedules L and M-1 v Force-print final end of year 2

Beginning of Year

1 Cash 1

2a Trade notes & accounts recw 2a
2b  Less allowance for bad debts 2b
3 Inventories 3
4 U.S. government securities............c...... 4
5 Tax-exempt securities........ SO 1
. I T 1T —— SCH2 Screen

B ) 1111
e A A

Figure 15: Beginning- and End-of-Year totals displayed on L screen (#1);
force printing end-of-year totals (#2)

Note that the totals from the balance sheet’s subsidiary schedules (SCH2 screen) also
appear in the BOY Totals and EOQY Totals columns of the L screen.

If you make any changes to the data, recalculate the return (press CTRL+C) for those
changes to be displayed on the screen.

Tl P To speed up calculation of returns that contain multiple states, open
screen 1 and select 0 from the Resident state drop list.

Force-Printing Final End-of-Year Totals

Normally, if you mark Final on screen 1, the program “zeros out” the EOY Totals
column of Schedule L. Mark the check box on screen L (item #2 in Figure 15) to force
those totals to be displayed in the EOY Totals column.

Flow of Information

Many of the entries made elsewhere on the return flow automatically to the generated
Schedule L (for example, inventory information from Form 1125-A). Depreciable
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asset information from the 4562 screen and intangible assets and amortization also
flow to Schedule L.

The SCH2 Screen

Statements

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in the
program. In other words, if you use this screen for all applicable lines on Schedule L,
you do not need to make any entries on the L screen.

All line selections are carried to the SCH2 screen in next year’s pro-
gram when the returns are updated, with this year’s year-end
amounts flowing to the beginning-of-year column in next year’s pro-

NOTES  gram

To access the SCH2 screen from the L screen, click one of the
SCH2 Screen links. The SCH2 screen is also available from the
General tab of the Data Entry Menu.

To create a statement for a line, select a line from the Line Number drop list of screen
SCH2 and enter descriptions and their corresponding amounts. Once the information
is entered, press PAGE DOWN to access a new SCH2 screen. If more detail is required
than can fit into a Description field, press PAGE DOWN, and on the new SCH2 screen,
select the same line number and then add to the description.

The total amounts entered on the SCH2 screen appear on the L screen in the BOY
Totals and EOY Totals columns. They are also printed on the return as applicable,
with references to the corresponding statements.

If a line is required, a statement (labeled “STATEMENT” or “STM” in View mode,
depending on your Setup Options) is produced and is e-filed with the return.

Note that an e-fileable “STATEMENT?” is referenced in the return, as shown in the
example of Figure 16.

Line Number

| »

1 Cash

2a Trade Notes and Accounts Receivable
2b Rllowance for Bad Debts

3 Inventories

4 U.5. Government Obligations =
5 Tax-exempt Securities
[

Other Current Rssets k {STATEMENT)
7 Loans to Shareholders
g Mortgage and Real Estate Loans
k] Other Investments {STATEMENT) =
1

02 Bui1i0g3ugiu 0T DeDRRIAhIE A9SCE b sttt N

o e ST, e P N P i) " e, .

IMENIOMES  « v v o v o v v v v v e a e e

U.S. gowvernmentobligations . « .« .« . .

Tax-exempt securities (see instructions)

Other current assets (attach statement)

Loans to shareholders . . .« . . . . ..

Mortgage and real estateloans . . . . . .
Other investments (attach st ) .

B T T

L= - - I

Figure 16: A selection of “Other current assets” from the Line Number drop list of
screen SCH2 attaches a statement and is referenced on the applicable line of the return.
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SCH2 and
Trial Balance

Autobalance

Typically, one or more SCH2 detail screens are needed for Schedule L items. If you
are using Drake’s trial balance worksheet feature, be aware that data for the SCH2
screens cannot be entered directly into the trial balance worksheet, and it cannot be
imported into the data entry. The SCH2 detail screens must be created apart from the
trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2
screen amounts.

For more information, see “SCH2 Detail” on page 57.

Autobalance forces Schedule L to balance for both the beginning- and end-of-year
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital
before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program
increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These dif-
ferences can come from amounts entered incorrectly but are usually the result of one
of the following causes:

* Anasset was deleted from the 4562 screen (Depreciation Detail) instead of being
indicated as sold.

* Beginning inventory amounts were adjusted on screen A, or ending inventory
amounts were entered incorrectly.

*  Amounts were erroneously deleted from or changed on screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and
select Turn off autobalance.

Schedules M-1, M-3 (Reconciliation of Books/Return)

Schedule M-1

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are
greater than $250,000. Page 1 of Schedule M-3 is required if the balance sheet’s total
assets at the end of the year equal or exceed $10 million, and Schedule M-1 and pages
1-3 of Schedule M-3 are required if the total assets equal or exceed $50 million.

Schedule M-1 shows all items of income and expense that are not subject to tax, plus
those accounting items that are not income tax items. When required, taxpayers must
reconcile book income with taxable income.

Tax Year 2015
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Depreciation

and
Amortization
Adjustments

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable.
Examples of both kinds of differences are shown in Table 2.

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference

Description

Examples

Permanent

Book or tax items that will never be
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary Iltems that will be reported for both - Depreciation
tax and book purposes, but not - Gains or losses on the sale of
during the same tax year depreciated assets

Favorable ltems that reduce taxable income - Instances in which tax depreciation

amount is greater than book depre-
ciation amount

Unfavorable

Items that increase taxable income

- Disallowed meals & entertainment

The program may make an adjustment for book-to-tax depreciation (or amortization)
differences. The calculation is done as described in the following steps. (This proce-
dure refers to “depreciation” throughout, but it applies for either depreciation or amor-

tization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 10b, column a) is subtracted from the “End of Year” accumulated depre-
ciation (line 10b, column c). This is the “book” depreciation amount.

2. This “book” depreciation amount is compared to the “tax™ depreciation amount.
(The “tax” depreciation amount is calculated from the Forms 4562, including any
section 179 amounts.)

3. The difference between the “book” and “tax™ depreciation amounts is carried to
the appropriate form and line.

* If the “book” depreciation amount is greater than the “tax” depreciation
amount, the difference is carried to one of the following locations:

— Schedule M-1, line 3a
— Schedule M-3, Part IlI, line 24 (as a negative amount)

— Form 8916-A, line 21 (as a negative amount for assets selected on the
4562 detail screen for COGS)

* Ifthe “tax” depreciation amount is greater than the “book” depreciation
amount, the difference is carried to one of the following locations:

— Schedule M-1, line 6a
— Schedule M-3, Part IlI, line 24 (as a positive amount)

— Form 8916-A, line 21 (as a positive amount for assets selected on the 4562
detail screen for COGS)
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Schedule M-3

Accessing
the M3
Screens

Screen
SCH3

Any domestic corporation or group of corporations that reports on Schedule L of
Form 11208 total assets at the end of the S corporation’s tax year that equal or exceed
$50 million must complete and file Schedule M-3 instead of Schedule M-1. If the

S corporation is required to file (or voluntarily files) Schedule M-3, it must file Form
1120S and all attachments and schedules, including Schedule M-3.

The Schedule M-3 section of the General tab of the Data Entry Menu provides
direct access to the following screens:

e M3, M32, and M33 — for Parts I, I1, and III of the Schedule M-3

* M3S — for supplemental statements

* SCH3 — for subsidiary schedules for Schedule M-3 and Form §916-A
* 8916 — for Form 8916-A, Supplemental Attachment to Schedule M-3

Certain income, deductions, gains, and losses flow from Form 1120S to Schedule M-3
in the program, but all other M-3 data must be entered manually on the M3 screens.

Parts Il and Il of Schedule M-3 reconcile financial statement net

N OTE income (loss) for the U.S. tax return (per Schedule M-3, Part I, line 11)

to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3
and 8916 screens.

For more information on using this type of screen, see “The SCH2 Screen” on
page 32.

If the corporation’s assets do not equal or exceed $10 million but the
corporation wants to voluntarily file Schedule M-3, or if the corporation’s

N OTE assets do not equal or exceed $50 million but the corporation wishes to

file the complete Schedule M-3, go to screen M3 and make a selection
from the Force print M-3 drop list. Choose to print just page 1 of
Schedule M-3 or the complete M-3.

Schedule M-2 (Analysis of Accounts)

N OTE On an 11208 return (unlike an 1120 return), Schedule M-2 is not a

reconciliation of retained earnings.

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjust-
ment Account. Schedule M-2 information can be entered on the M2 screen and else-
where in the program, but most information is carried to the M-2 automatically. See
“Entering Distributions” on page 36.

Schedule M-2 represents a corporate picture of the income, losses, and distributions to
shareholders and tracks tax-free distributions and helps determine if excess distribu-
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tions might be taxable to shareholders. If a shareholder receives more in distributions
than he or she has in basis, the result might be taxable.

Entering Distributions

Code Section 6037 states that an S corporation return must report the amount and date
of distributions made to each shareholder. Use the DIST screen for reporting date and
distribution amounts for Schedule K, line 16d, “Distributions.” In addition to line 16d,
the total from the DIST screen may flow to Schedule M-2, line 7 (subject to limita-
tions) and to the Schedules K-1 based on the shareholder’s ownership percentage.
Schedule K-1 distribution information is displayed on the K1 _DIST worksheet pro-
duced with the return.

N O—l—E The DIST screen is available from the General tab of the Data Entry

Menu, or enter DI ST in the selector field and press ENTER.

Column A, Accumulated Adjustments Account

The “Accumulated Adjustments Account” column of Schedule M-2 generally reflects
the S corporation’s accumulated undistributed net income after 1982. Non-dividend
distributions flow to Schedule M-2 from Schedule K, line 16d. An entry in the “Non-
dividend distributions” line of the M2 screen adjusts the amount from the K screen
(subject to limitations; see balance-sheet examples on the following page). See the
field help for line 7 for more details.

Distributions reported on line 7 flow differently from the amount entered on the DIST
screen. (See the previous section, “Entering Distributions.”) The distributions are lim-
ited following the ordering rules under Reg §1.1368.2.

Tl P See Form 1120S instructions for more details and examples.

These rules are for Schedule M-2, column a:

* Line 1 balance — The balance at the beginning of tax year, line 1 is either
zero or the balance carried forward from line 8 of the previous year. Due to
prior-year net losses and reductions, the amount on line 1 can be negative.

* Changes to AAA — The Accumulated Adjustments Account (AAA) is
increased for ordinary income from page 1, line 21 (line 2) and other additions
listed on line 3. The AAA is then decreased for any loss from page 1, line 21
(line 4) and other reductions listed on line 5.

* Reduction of AAA — Once these adjustments are made, the AAA is reduced
by ordinary distributions on line 7, but not less than zero. Thus, if the distribu-
tions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to
$10,000. If line 6 is a negative number, then line 7 will be zero (in this exam-
ple). To allow an amount on this line would take the AAA to a larger negative
number. (That is, even more below zero than it really is).
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Important
Note about
the AAA

Schedule M-2 ltem Amount
Ling 1 Balance at beginning of tax year ($11,786)
Lines 2 & 3 Ordinary income and other additions $£58 440
Lines4d &5 Loss and other reductions ($439)
Line 6 Combine lines 1-5 $46 165
Line 7 Distributions (total $60,000) ($46,165)
Line 8 Balance at the end of tax year $0

The rules from the preceding chart apply when the net adjustment for lines 2 through 5
is positive. When the net adjustment for lines 2 through 5 is negative, the ordering
rules are switched and AAA is decreased by ordinary distributions (but not below
zero) before the net negative adjustment for lines 2 through 5.

Sch. M-2  Item Amount

Ling 1 Ealance at beginning of tax year 11,786
Line B Met negative adjustment (lines 2-5) ($57.951)
Line 7 Distributions {total $60,000) ($11.786)
Lined EBalance at end of tax year ($57.951)

A corporation can make distributions greater than the amount on line 6 of the M-2, but
those distributions could be taxable to the shareholders. Enter distributions on the
DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but
are limited based on the rules described previously. (For more information on the
DIST screen, see “Entering Distributions” on page 36.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line
6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1
and line 6 are both negative, line 7 is completely disallowed on the Schedule M-2.
Distributions are entered on the DIST screen to be reported to the shareholders,
regardless of the Schedule M-2 limitation.The AAA cannot be negative as a result of
distributions, but it can be negative if it arises from losses.

Column B, Other Adjustments Account

Use column b, Other Adjustments Account, of screen M2 to enter any amounts you
want printed in the corresponding column of the printed return. Officer life insurance
and applicable tax-exempt income flow to Schedule M-2, column b (“Other adjust-
ments account”), line 5. All other amounts (such as expenses) must be entered manu-
ally on the M2 screen.

Column C, Undistributed Taxable Income Previously Taxed

The total of column ¢ cannot be negative. This column is active in an 1120S only if the
entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it was
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a pre-1983 S corporation. By design, Drake does not allow negative numbers in col-
umn c.

If a corporation becomes an S corporation and has net operating losses (NOLs), the
NOL is not generated for the return because it cannot be carried to an 1120S (the IRS
does not want the NOL to be used by the shareholders to offset income); it either runs
out within the years allowable for the NOL by statute or is used if the S corporation
terminates its “S” status within those years.

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental
Real Estate Income and Expenses of a Partnership or an S Corporation. To make
entries in Drake, use the 8825 screen.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use
one screen per rental property. If a return has more than one 8825 screen, the program
reports each property’s information on a separate column of the “Properties” section
of Form 8825 (up to eight properties can be included on a form). Data from all 8825
screens are transmitted to the IRS when the return is e-filed.

N OTE Special steps are required if using the trial balance worksheet for multi-

ple rentals. See “Rental Expenses” on page 58.

Line 14, Depreciation

Carrying
Information
to Form 8825

If the program is calculating depreciation (entered on the 4562 screen) for the property
listed on Form 8825, do not enter the depreciation on the 8825 screen. Depreciation
should be entered only if it is figured outside of the Drake program, and then the net
results should be entered on screen 8825. The amount entered on line 14 of screen
8825 is added to the depreciation calculated from the 4562 screens.

N OTE Form 4562 is required for assets placed in service during the year.

To indicate that the information should be carried to Form 8825, select 8825 from the
For drop list on screen 4562 (Figure 17 on page 39). If there are multiple 8825
screens, use the Multi-form code box. For information on using the Multi-form code
box, see the Drake Software User's Manual: Tax Year 2015.
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Form 4562 For |z225 ~\ 1120S, COGS, 8825, RENT, F
Multi-form code: 2 (1-999; 1 is assumed if left blank)
Date
Description Acquired Cost/ Basis r
|rental units |o1-01-2010 | 554433
o AR e b A e ol R, yw--u-m_r--q?

Figure 17: In this example, the program will carry the 4562 information
to the second 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct
Form 8825, based on the form and multi-form code selections at the top of the 4562
detail screens.

When selecting a multi-form code, note that the code
should refer to an 8825 screen—not the 8825 form. For
example, data from the second 8825 screen will be gen-

| M PO RTANT erated on the first Form 8825. To associate an asset with
that information, you would enter a 2 for the screen (not
a 1 for the form) in the Multi-form code box. For more
information on Form 8825, see “Viewing Rental Activity
Information” on page 40.

N OTE Drake now produces a Form 4562 for each property on Schedule E and
Form 8825 instead of one Form 4562 for Schedule E or Form 8825.

Line 15, Other Expenses (list)

Enter meals and entertainment (subject to 50% limit) in the appropriate field on line
15 of the 8825 screen. To enter additional other expenses, begin typing into the Addi-
tional other expenses field to open a Detail (CTRL+W) Worksheet. Enter descriptions
and amounts on this worksheet.

A statement from each 8825 property is printed with the return and is submitted to the
IRS when the return is transmitted.

P e e e PR S e e e T e
Wagst ¥hd salanes < T S :

53
14 Depreciation (see instructions) . . . . . 14 20,159 ;
15 ﬁ'ﬁ' llistiMMeals / Entertainment 1,1114%
SEE STM 8825 02 3,333 /@
N 8 } |
16  Total expenses for each property. 3
Add lines 2 through 15, . . . . . . .. 16 24,603
17  Income or (Loss) from each
praperty. Subtract line 16 from line 2. . 17 12,345 (2,381)
483 aTote] pssdaai, idaasgeents fim line 2_solpmnghthauaii o pen gt

Figure 18: Other expenses are listed on Form 8825 and on accompanying statement;
in this instance, “STM_8825 (02”
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Use the K1P screen to enter rental income the S corporation receives on a Schedule
K-1. This amount is carried to Form 8825, lines 20a and 20b. No entry is required on
the 8825 screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

8825 Forms — The two-page Form 8825 can contain information for up to
eight rental activities. Each Form 8825 in View mode contains up to eight
rental activities. If more are entered, a second Form 8825 is created
(Figure 19).

. 11205EF

11205
11205 P52
11205 P53 Rental activities #1.8
n20s.Pe4 L~ Rental activities #1-
aas €|
825 ——— | Rental activities
STATMENT starting at #9
WK _M2

FOLDR
FILEINST
LETTER
PRIVACY
BILL
SUMMARYS
COMPARES

Figure 19: Multiple 8825 forms are created if there are more than eight rental activities

Form 8825 in View mode consists of one or more pages (depending on the
number of rental activities) listing up to four rental activities per page. If more
than four rental activities are entered, scroll down to the second page of the
Form 8825 when viewing.

8825 Statements — Depending on your Setup Options, statements are titled
STM_8825 XX, where XX equals the instance of the 8825 screen. (For
example, the statements for the first and second 8825 screens would be
labeled STM_8825 01 and STM_8825_02, respectively.) There are also
8825 attachments (8825_ATT) for other reporting information.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The program car-
ries the required adjustments to the appropriate line of the return and to either Sched-
ule M-1 or Schedule M-3.

Manually reducing the expenses or deductions or increasing the income for these
credits causes the return to be out of balance.
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Elections

Access the ELEC
screen from the
Miscellaneous tab
of the Data Entry
Menu.

Adjustments are made to other income for the credit amounts for the following cred-
its:

Form 6478, Biofuel Producer Credit
Form 8864, Biodiesel Fuels Credit
Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction or expense for the credit amounts
for the following credits:

Form 5884, Work Opportunity Credit

Form 6765, Credit for Increasing Research Activities

Form 8820, Orphan Drug Credit

Form 8845, Indian Employment Credit

Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

Form 8881, Credit for Small Employer Pension Plan Startup Costs
Form 8844, Empowerment Zone Employment Credit

Form 8912, Credit to Holders of Tax Credit Bonds

Form 8932, Credit for Employer Differential Wage Payments
Form 8941, Credit for Small Employer Health Insurance Premiums

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Election drop list on the ELEC screen (Figure 20).

Return Elections

Election. ... | ﬂ

Description......ooooee |

Cost, basis, amount, years.........
Date oryear-ending..........ccocoo.o....
Other cost, basis, oramount......

Other date or year-ending............
City. |
COUNtY. o |
. | jv

Explanation.........cocoeveeeeen

Other information

o Bl s AR B e gt n AR e s TN

Figure 20: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the S corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry

Menu).
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2. Make a selection from the Election drop list (Figure 21).

Return Elections

Election...... ﬂ

General Election Statement

Capitalize and Amortize Circulation Costs over 3 Years

Capitalize and Amortize Research and Experimental Expenditures
" Capitalize and Zmortize Intangikle Drilling and Development

_J)ate oryear-ending.....................

ik i AD S SRRITALAZA, 0T BROTI A MR A DAL ANFERICLTE s et P

Description...........cooooooe. 02 :

Cost, basis, amount, years....... 03

Figure 21: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if a field is
required for your selection and the type of information that may be needed. For
example, the help text for the Other date or year-ending field shows that the
field is required only for election options 15, 27, 28, 29, and 31, and it explains
what, specifically, should be entered for each of these elections (Figure 22).

Drake Software - Data Entry - Help

Other Date or Year-Ending (direct entry)

Enter any additicnal date or year ending information required
for the selected eletion.

The descripticon field is used on the following election statements
for this package:

5T # Taze:
15 Date of Qccurrence
27 Shareholder's signature date
25 Officer's signature date
29 C Corp tax return ending date
31 Shareholder's tax year
LN TR T —_ 4.'-1‘.Hﬂvﬁhth“"‘"\ﬁ"‘k“d"pbmu-“mmy‘

Figure 22: Help text for Other date or year-ending field on ELEC screen

If the election option you selected is not listed in the help text for a field,

N OTE then that field should be left blank. For example, if you chose election
01 (General Election Statement), you would not need to enter any-
thing into the Date or year-ending field (help text in Figure 22).

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the
election. For example, election 01 (General Election Statement) is generated as “STM
ELO1” or “Statement EL01,” depending on your selections in Setup Options.

The election statement includes the election title, election wording, and any additional
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other
times, they are included as separate lines. Signature lines are printed as needed on
some statements.
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Safe Harbor Elections

Use the Building qualifies for Section 1.263... check box on screen 4562 to apply a
small taxpayer Safe Harbor election to a building listed in the Description field. An
election statement will be produced and the building description as entered in the
Description field will be included in the election statement.

N OTE This Safe Harbor election covers buildings only.

See IRS Reg. section 1.263(a)-3(h), IRB 2013-43, Rev. Proc. 2014-16, and Rev. Proc.
2015-14 for guidance.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

Suppressing/Forcing ltems

To suppress the printing or production, or force the printing or production, of certain

documents, go to the PRNT screen and select the desired options. Many “on-the-fly

29

changes override the options established in Setup Options.

1120S Items  These items can be “forced” (forcing the program to generate the item) on a return:

1125E Officer Information

Schedules L and M-1

Form 4562 (Depreciation and Amortization)

Next-year depreciation listing

“Inactive return” printed on first page of the 1120S
Preparer and officer signature on printed copy of return

The following 1120S items can be “suppressed” (kept from being generated) on a
return:

Schedule M-2
WK M2 (Retained Earnings Reconciliation Worksheet)
Form and worksheet references

Form and worksheet references are for the benefit of the preparer
and client but are not required for the tax return. References appear

N OTE on tax forms to clarify which worksheets (available in View mode) cor-

respond to which calculations, and which forms/screens certain
amounts are carried from.

K-1 ltems The following K-1 items can be “forced” (forcing the program to generate the item)
on a return:

Shareholder’s adjusted basis worksheet (WK_SBAS)

Tax Year 2015
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¢ K-1 codes (page 2 of the Schedule K-1)
The following K-1 items can be “suppressed” (kept from being generated) on a return:

* Related documents: Schedule K-1, K-1 cover letter, K1 ATT worksheet (for K-1
statement overflow), and shareholder’s adjusted basis worksheet (WK _SBAS)

* Marking of “Amended K-1" box on printed Schedule K-1
e KI1-DIST worksheet

Overriding Other Setup Options

Filing instructions and envelope coversheets can be either forced or suppressed from
the PRNT screen to override the global setting in Setup > Options > Optional Docu-
ments tab.

The PRNT screen also includes options to disable autobalance (see “Autobalance” on
page 33), calculate the Form 2220 penalty, and prepare an extension (Form 7004)
based on the data entered on screen 1. (See “Filing an Extension” on page 17.)

Electronic Filing

Steps to e-file Form 11208 are the same as to e-file Form 1040, with the exception of
bankruptcy returns, which must be paper-filed.

An S corporation with $10 million or more in total assets that files
250 or more returns a year is required to e-file its Form 1120S
returns.

N OTES Every 1099, W-2, 940, and 941 form that is filed is counted as part

of the 250-return threshold. For example, if a corporation filing an
11208 return also files 150 W-2 forms, each W-2 would count as a
separate return within the 250-return threshold.

Calendar year returns are due on March 15, 2016. Fiscal year returns are due on the
15th day of the third month (two and a half months) after the S corporation’s year end.
Returns can be e-filed after these dates; however, if an extension has not been filed,
penalties and interest are applied.

Additional Return Types

Electing a

52-53-Week

Year (Initial
Return)

Short-year returns, 52—-53-week year returns, and inactive returns can all be e-filed
using Drake. For information on how to indicate a short-year return in Drake, see
“Short-Year Returns” on page 5. Information on e-filing 52—53-week returns is pro-
vided in the following sections.

To elect a 52-53—week year, a new entity (one that has never filed a return) must enter
data on both screen 1 and the Year screen.

To elect a 52-53—week year for any entity:
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1. In the If not calendar year section of screen 1, enter the Fiscal year begins and
Fiscal year ends dates. Use MMDDYYYY format, as shown in the example in
Figure 23.

2. Mark the 52-53-week tax year box.

If not calendar year

Fiscal year begins.......... '39 24-2015
Fiscal yearends..._._._._. ':'9 25-201&
v 52-53 week tax year Year

Figure 23: In this example, the fiscal year begins 09/24/2015 and ends 09/29/2016
(the Thursday closest to the end of September), giving the entity a 53-week year for 2015.

An entity that has filed returns in the past must complete only steps 1
N OTE and 2 of this process. An entity that has never filed a return before must
continue with steps 3 through 6.

3. Click the Year link to open the Short Year Elections screen (Figure 24).

Short Year Elections

52-53-Week Tax Year Election

1 Month in which new 52-53-weektaxyearends. ... hd
2 The day ofthe week on which the tax year always ends........ hd
3 Thedatethetaxyearends. ...

Figure 24: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53—week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the
Fiscal year ends field on screen 1).

Once a 52-53—week year is selected, the entity must use that account-

N OTE ing period every year. To change accounting periods, the entity must
submit to the IRS Form 3115, Application for Change in Accounting
Method.

In subsequent years, only the 52-53—week tax year check box on screen 1 must be
marked; the program automatically updates the dates.

Inactive Entities that are inactive but are still required to file returns may e-file inactive returns
Returns in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on
the main form of the return (specifically, in the box above line 1¢). Zeros are displayed
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where required by the IRS in order for amounts to be properly included in the e-file
data.

N OTE All EF messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake, see Drake Software User s Man-
ual: Tax Year 2015.

Common Error Codes

If one or more of the following IRS error reject codes is generated when e-filing an
11208 return, the preparer must contact the IRS for further information. The IRS
e-Help Desk telephone number is (866) 255-0654.

* Reject Code R0000-900-01 — The return type indicated in the return header
must match the return type established with the IRS for this EIN. If you get this
reject code, you must contact the IRS to correct its database or paper-file this
return.

* Reject Code R0000-905-01 — Electronic Filing Identification Number (EFIN) in
the return header must be listed in the e-file database and in “accepted status.” If
you get this reject code, you must update your e-file application to include the
11208 return type. This should be done at the IRS website. Review publication
3112 for details.

* Reject Code F1120S-239-01 — Filer’s TIN and Name Control in the return
header must match data in the e-file database unless Form 1120S, Item H (2),
“Name Change” box is marked.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed
appraisal statement. In some instances, the IRS requires that a document be attached
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed and
scanned into the computer (or “saved” as a PDF document), and attached to the return
in order to be e-filed with the return.

You can attach PDF files to federal S corporation 11208 returns for e-file. The PDF
Attachments screen is accessible from the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-file
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These steps are described in the following sections.

Creating a To create a PDF file:
PDF File

1. Scan the document to be attached to the return.

Tl P It's a good idea to use the DDM scanning feature for this step.

2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Many types of documents (for instance, documents created in Microsoft
N OTE Word) can be printed or “saved” as PDF documents if you have a PDF
printer (such as Adobe Reader) installed.

Adding PDF  To indicate in the software that a PDF document will be sent with the return:

Documents
in Drake 1. Open the return in Drake. From the General tab of the Data Entry Menu, click

PDF Attachments or type PDF in the selector field and press ENTER (Figure 25).

—mr— B e

"UBAS  Businés Aciity Statsméntiiiocation

DIST Distributions Electronic Filing
K-1 Information PIN e-File Signature
K1 Schedule K1 Shareholder Information DD Direct Deposit
K1G Global Supplemental Information PMT  Electronic Funds Withdrawal
OWN  Shareholder Ownership Changes EE EE Selection

GDF PDF Attachments @
Schedule L Balance Sheet
L Assets, Liabilities and Equity FAQ  Frequently Asked Questions
SCH2 Balance Sheet Subsidiary Schedule PRNT Print Options

( [PoA )

Figure 25: Select PDF Attachments, or type PDF' into the selector field and press ENTER

2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

Name of Column Description Examples
Reference Source Name or number of regulation, - IRS Pub xxx-1.4
publication, or form instruction that | - Form Instructions for 1120S

makes attachments necessary

Description Description of form or documentto | - Title of house on Oak Street
be attached - Appraisal of Lot 1234

File name Distinctive, easily recognizable file | - TitleHouseOakSt.pdf
name, followed by “.pdf’ - AppraisalLot1234.pdf

3. Exit the PDF Attachments window.
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Attaching
Documents
to the Return

Because you’ve indicated that a PDF document is attached, the program generates an
EF Message regarding the attachment when the return is calculated.

To attach a PDF file to a return:

1. From the toolbar, click View. If anything was entered in the PDF Attachments
window (see “Adding PDF Documents in Drake” on page 47), there will be two
PDF-related items in the View/Print window:

* An EF Message (item #1 in Figure 26)
* An Attach PDF button on the toolbar (item #2 in Figure 26)

m o, @2 O @ YL )\e

Data Entry PFrint Sign Setup Archive Email Fefrezh  Basic'iew K1 Expory Attach PDF I-I-el

—

Select Forms to Yiew/Print 2

All Forms | Sets | EF | Federal | Worksheets | Motes/Messages | Morth Carolina |
| Federa .

U.8.Income Tax Return for an S Corporatiol

Fam 1 1 205 p Do not filethis form unless the corporation hasfiled oris
.t y ing F 2653 to elect to beap S corporation
(Tgiaisoe Lt s it e AHEERING FORT \*.‘_‘Tﬂ‘*\‘fm__‘j‘.pldq.,

Figure 26: The MESSAGES file (#1) and the Attach PDF button (#2)

2. Click the MESSAGES file to view EF Messages, including information on how
to attach the required documents to the return.

3. Click the Attach PDF button. The EF PDF Attachments window displays the
information entered on the PDF Attachments window in data entry (Figure 27).
A red X means the document has not yet been attached; a green check mark indi-
cates an attached document.

Drake 2015 - EF PDF Attachments (=230l

Required PDF Attachments

The ligt below containg PODF Attachments that are required for electronic filing. Select an itern from the list and click
‘Browse' to locate the azzociated POF file, lteme with a green check mark, already have the PDF file, ltems with a red =
are mizzing the required POF File.

| Rieference Description Required PDF FileMame
0 Form 2553 FORM 2553.FDF
@ IRS pub 526 Apprizzal of Lot 1234 APPRAISALLOT1Z234.PDF
@ Form Instructions fo Title of house on Oak St HOUSETITLEOAK.PDF

e mm‘*h__q_’-*&-—.\ it Aol e ol Nt e s 2 - Sl o

Figure 27: The EF PDF Attachments window

4. Click the row of a document to attach.

o

Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a

completed return, recalculate to clear the EF Message. The return is now ready to be
e-filed.
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Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and
scanned back into the computer to be attached to the return. For example, if Form
2553, Election by a Small Business Corporation, is present in an S corporation return
(and the Attaching Form 2553 as a PDF document check box is marked on screen
1), EF Message 1513 is generated when the return is calculated.

1513 ATTACH FORM 2553: The check box for "Attaching Form 2553 as a PDF
document" on screen 1 has been marked, but no Form 2553 has been
attached. Form 2553 must be prepared and attached before the return
can be e-filed.

To prepare Form 2553 for attachment:

Ensure that the 2553 screen has been completed in data entry.
Calculate the return.

In View/Print mode, select and print Form 2553.

Have all shareholders sign the form.

=W N

To attach the signed Form 2553 to the return:

1. Scan the signed form and save it as a PDF document.

2. Go to View mode of the return.

3. Attach the scanned PDF document to the return using the PDF icon
at the top of the screen.

For detailed instructions on attaching this form to a return, go to
the FAQ screen and click "Attaching Form 2553 as a PDF Document."

e O b N o B s S AN BN i o g A

Figure 28: EF Message requiring PDF attachments

As shown in Figure 28, the EF Message states that attachments are required. You
would then need to print and then complete the statements, scan them into the com-
puter, save them as PDF documents, and attach them to the return.

Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120S return
from a trial balance worksheet. The trial balance template and importing function has
the following benefits:

¢ Eliminates the need to duplicate entries
* Reduces data entry errors by automatically importing data to the correct fields

* Allows preparers to merge basic accounting functions with tax preparation

N OTE A flow chart of the trial balance importing process is available as an
appendix at the end of this manual.

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in
Drake 2008 or later. Like several other functions of the tax program, this feature
requires Microsoft Excel (version 2000 or later).
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First, if you haven’t already, create a client file (open a new return) in Drake or update
an existing client file from the prior year.

Then take the following steps to ensure the trial balance import works properly:

* Activate Macros — The trial balance import function uses macros in Microsoft
Excel. Check your Excel settings to ensure that macros are activated and that
macro settings are set to “Disable all macros with notification.” To do so, go to
File > Options in Excel and select the Trust Center tab. Click Macro Settings
and select Disable all macros with notification, then click OK.

In Excel 2007, click the Office button in the upper left and then click the
Excel Options button at the bottom of the window. In Excel 2010 and
2013, click the File tab then select Options from the menu on the left.

N OTE Next, select Trust Center from the list at left, then click the Trust Cen-
ter Settings button. Select Macro Settings from the list on the left,
then choose Disable all macros with notification. Click OK and then
OK.

* Disable Autobalance in Drake — (optional) When autobalance is disabled, the
program is prevented from automatically adjusting the year-end retained earnings
or capital amounts, thus allowing you to see any discrepancies in the balance
sheet. To disable autobalance, go to the PRNT screen and select Turn off auto-
balance (Figure 29).

Calculations and Other Options

[w Turn off autobalance

[ Calculate Form 2220 penalty

[~ Prepare Form 7004 based on screen 1 data

For an extension to include payment information, screen 4 may also
need to be completed.

Figure 29: Disable autobalance in the
Calculations and Other Options section of PRNT screen

* Force Schedule L — By default, Drake does not display the balance sheet
amounts on the return if the entity does not meet the filing requirement. If this is
the case, you will have to override the default setting in order to have the amounts
shown on Schedule L. To force the Schedule L amounts to be printed, go to the
PRNT screen and select the Force-print Schedules L. and M-1 box (Figure 30).

Items to Print
[ Force-print 1125E Officer Information
[~ Force-print Schedules L and M-1

[+ Print Form 4562

[~ Print next-year depreciation listing

| D pmtinacte g e J
Figure 30: Force Schedule L box for 1120S package
*  Check for Detail Worksheets — The trial balance import allows only those

detail worksheets required by the IRS. Check updated returns for detail
(CTRL+W) worksheets that are not required. For example, the IRS does not
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require a detail worksheet for the Gross receipts field on the INC screen; if a
return has a detail worksheet for that field, the trial balance will not be imported
correctly into the return. Detail worksheets are indicated by red shading, as shown
in Figure 31.

Income and Common Schedule K ltems

Form 1120-S - Income

18 GIOSE TECRIPES O SAIBS .. ooeoeeiceoee e et sss e oss e st st s e sns s 543210

1b  Returns and allowances plus any "cash back™ included on line 1a....
2 Cost of QOOAS SO e 1125-AScreen
Other Income
Lf___* A Tl e A et T i NN e \.x_r?_“.,\\}-‘_.‘qr-quﬂn

Figure 31: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets”
on page 53 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

Opening a
Template

=
Impart

File Location

To prepare the financial data for importing into the return, the data must be entered
into Drake’s specially designed trial balance template. Once this information is
entered and saved, it can be imported into the return.

The first step in preparing financial data for importing is to open a trial balance tem-
plate for the return and enter the financial data.

To open a trial balance template for a return:

1. Open the return to the Data Entry Menu.

2. Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after
selecting the correct file.

4. 1f a Security Warning box appears, click Enable Macros.

In Excel 2007 and 2010 you may see a Security Warning message

N OTE with an Options button. Click Options to open the Security Options

dialog box, then select Enable this content. Click OK. (In Excel 2013,
click Enable Content.)

The trial balance template is displayed in Microsoft Excel.

Whenever a new template is opened, the tax software assigns it a default file location
and name. Trial balance templates are saved in the TB folder of your Drakel5 soft-
ware.

Tax Year 2015
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To change the name of a file in Excel, select File > Save As and assign the new name.

N OTE If saving a trial balance to a different location, make a note of where
you store it. The program automatically looks in the default directory.

Template The trial balance template consists of three title rows and six columns. The Entity
Structure  Name and Year End title rows can be edited; double-click a row to change the title.
Columns are described in Table 4.

Table 4: Trial Balance Template Columns

Column Description
Account Title Title of account
Debit/Credit Debit and credit amounts
Import to Screen and line in Drake to which the debit or credit
amount is imported
Reported on Location of the amount on the printed return
Other information Additional details for preparers; see “Details for Pre-

parers” on page 56.

Displayed at the bottom of the trial balance worksheet are the calculated amount for
Schedule M-1, line 1; the credit and debit totals; a cell showing whether or not the bal-
ance sheet is out of balance and, if applicable, the out-of-balance amount (Figure 32;
see also Figure 35 on page 54).

I e I T
Salariés and wanEs - shareholder gmployees - - gy i
Wigste remaval $0
‘le
6&'{ Income {Lassi= Schedule M-1, line 1
F100 600
|
(2
@als $549 850 $549 850}
| — 3
QHT OF BALANCE? 0

Figure 32: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to
assemble financial data for importing into data entry.
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Entering Financial Data

Direct Entry

When a new trial balance file is opened for a return, all debit and credit amounts are
zero ($0). All data must be entered manually into the template.

Some data cannot be imported with the trial balance and must be
N OTE entered directly into the data entry fields within the program. For more
on these categories of data, see “Special Conditions” on page 56.

Most cells in the trial balance worksheet are view-only. In a new template, editable
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Detail Some cells require more detail than can be entered on a single line. These cells are
Worksheets indicated by buttons. (Figure 33) If these cells do not work, you may need to active
them; see the Note in “Opening a Template” on page 51.
! 30 K, ling & Schedule K, Iini
4 30 does not carry detail required
|
5 doea-fotearry detail required
,5_ ________________ 0. Bookincome | uires detail
S ). Otherincome |} it uires dea
b sl SIS TN | uires detal
3 Sch K Deductions uires detail
!r/r/..
;///////// i
;
k: & ling 2 Form 1125-4,
Figure 33: Example of cells that require worksheets
Click a worksheet button to open a worksheet in a new tab. Figure 34 on page 54
shows an example of the “Other Income” worksheet.
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1 Statement Required - Other Income
2 Form 11208, page 1, line &; INC line &
3
4
5
6 Line Description Amount Import to:
7 | 1 |Amount of credit for tax on fuels (Form 4136) 50| INC, line 5
8 | 2 |Interest income on receivables 30 INC| line &
9 | 3 |Recoveries of bad debts deducted in earlier years 50 INC. line 5
10 | 4 |Section 481 adjustments 50 INC, ling &
11| 5 |State tax refund (cash basis) 50| INC, line 5
12 6 |Taxable income from insurance proceeds 50 INC. line 5
13| 7 |Other $0(  Other Income Detail I
14 @
15
16
17 Total other income 50
18
19
20
g; ( Click to return to TB 2
37
3 (aD\

SBS TB Other Income

Figure 34: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the SBS TB tab (labeled “1” in Figure 34),
or click the Click to return to TB button above the worksheet tabs (labeled “2” in
Figure 34). Note that a detail tab (the “Other Income” tab in the lower left of

Figure 34) might include one or more detail worksheets (labeled “3” in Figure 34).

Do not create detail worksheets in data entry of the tax software if the
N OTE trial balance worksheet does not provide an equivalent detail worksheet
or the trial balance will not be imported correctly.

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are
out of balance, the worksheet highlights the out-of-balance amount (Figure 35).

pre— Ce= T
e e B s

Totals

i

LY

——

512,500

54100

OUT OF BALANCE?

55,800

> M| SBSTB ¥

Figure 35: Out-of-balance amount is highlighted if columns are out of balance.
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In addition to credit and debit totals, the main trial balance worksheet shows the net
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

N OTE The data cannot be imported if the worksheet is out of balance.

Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In Excel
2007 and 2010, click the Office button in the upper-left corner and select Save. In
Excel 2013, click the File tab then Save.) To re-name a file when saving, select File >
Save As. Trial balance templates are saved in the “TB” folder of your Drakel5 soft-
ware.

Importing Data into a Return

Once a trial balance worksheet has been set up for a client in Drake, the trial balance
information can be imported into the program and calculated into the return.

Not all trial balance data can be imported directly into a return. For

information on program limitations, see “Special Conditions” on
NOTES P

If you are already in the Trial Balance Import tool for the selected

return, go to the Trial Balance Import window in Drake and start at

Step 3 of the following procedure.

To import a trial balance into a return:

=N 1. Open the return to which you will import the trial balance information.

-

2. Click Import > Trial Balance Import from the menu toolbar. The preliminary
Trial Balance Import dialog box is opened.

Click Next.

4. Enter or select the trial balance file to be imported. If necessary, click the button to
the right of 1. Import File Name to browse to the proper folder. By default, each
trial balance file is an Excel (.xls) file showing the client name and ending in
“TB” for trial balance, as shown in the example in Figure 36. (See “File Location”
on page 51.)

Import

g

1. Import File Mame |E:\DHAKE15\TB\ESS Bee Ess CopTB.%LS @

Figure 36: Selected file to import

5. Select the Trial Balance Additional Import Options. (See “Additional Import
Options” following this procedure.)

6. Click Next and wait for the import to be completed.
7. Click Finish.
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The program returns to the Data Entry Menu for the open return. Note that all
selected data from the trial balance worksheet has been imported into the return. This
can be seen both in the data entry screens and on the generated return.

If the program does not calculate the trial-balance information as
N OTE expected, you can return to the trial balance worksheet, make adjust-
ments, and import the worksheet again.

Additional The program can import the following additional information when importing the trial
Import  balance data (select the items to import or click Select All):

Options
Buildings & other depreciable assets ~ Accumulated depreciation
Land Goodwill & other intangible assets
Accumulated amortization 8825/Rent information

Cost of goods sold depreciation

Special Conditions

Some items cannot be entered into the trial balance worksheet and must be typed
directly into data entry. Other items should be entered into the worksheet for balance
purposes but are not imported to data entry; these must be entered separately and the
calculated results compared to the trial balance worksheet.

Details for Most items go directly to the location indicated in the program and on the return. For
Preparers example, the amounts shown in Figure 37 go to Schedule L, line 1, column d in the
program and are shown on page 4, Schedule L, line 1, column d, of the 1120S return.

Debit Credit Import to: Reported on: h
GQD-,D-SD L, ling 1, cold Form 11205, Sch L, line 1, CD|D
30 L, line 2a, colc Form 11205, Sch L, line 2a, colc
o P _rmm—m\uﬁq?yﬁ““‘~ ot al o Fasmd 1205 Coltting 2hanl gt

Figure 37: Indication of where an amount will go in Drake and on the return

The “Other Information” column in the trial balance worksheet indicates special con-
ditions and additional information regarding certain rows. Table 5 describes the most
common notes in this column.

Table 5: “Other Information” Column Notes

Note Description

not included in totals The amount is required for importing purposes only but is
not included in the totals shown on the trial balance.

does not carry Information cannot be imported and must be entered on the
appropriate screen in Drake. Screen is specified in
“Reported on” column.
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Table 5: “Other Information” Column Notes

Note

Description

optional

Amount is optional; not required for import, but could require
direct entry in the software.

include deficit as negative
number

Some deficits must be entered as negative numbers.

import includes the calculated
change in inventory

Used for “total purchases”; when calculating cost of goods
sold (COGS) in the return, the program takes the change in
inventory into account for the Form 1125-A calculation.

[Form or Schedule] may be
required

Non-financial information must be completed in Drake, in
addition to the financial data entered in the worksheet.

All “does not carry” notes are accompanied by further instructions in the “Import to”

column to the left of the “Reported on” column, as shown in Figure 38.

SCH2 Detail

required for an item marked “does not carry” on the trial balance.

Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is

Other Information

ety o b,

P P PV

SV

Account Title Debit Credit Import to: Reported on:
P . [ e ‘ln-l‘E'ELCP.',‘LN_‘- o sttt | oo ERIM11205, Sch L fine 1, colds ot
T T T ot e et e e e s e o pat e T e

U.S. government securities 50 L, line 4, cold Form 11205, Sch L, line 4 cold

Tax-exempt securities 50 Lline S cold Form 11205 Schl lne S cold

Other current assets 30 Other current assets detail SCH2 detail required in Drake does not ca@

Loans to shareholders 50 L lne7, cold Form 11205, Sch L, line 7, cold

Mortgage and real estate loans 30 L lned cold Form 1120; chl lned cold

Other investments 30 Other investments detail SCH2 detail required in Drake does not carD

Buildings and other depreciable assets 30 L, line 10a, col c Form 112053, Sch L, line 10a, colc optional

Accumulated deprgciation 50 L, line 10k, colc Form 11205, Sch L, lipe 10b, colc optional
. \L.“,_‘Ap‘v-&u. B e Tt N PRS- ST PSSP Sy | ',,-_AA_‘.._A-,‘..._--;—-

.. o, P b k.

Figure 38: SCH2 screen in Drake is required for “do not carry” items on trial balance

To complete an SCH2 detail screen in data entry:

1. In Drake, open the SCH2 screen in the return.
2. Select the line number from the SCH2 drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat
steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts
imported from the trial balance worksheet and the totals of the amounts entered on the

SCH2 screen.

See “The SCH2 Screen” on page 32 for more details on using the SCH2 screen.
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Depreciation

Rental
Expenses

S corporation returns can have up to four components of total depreciation:

* COGS

* Real estate rental

* Rental other than real estate

* Any remaining depreciation

For trial balance purposes, enter depreciation amounts directly into the appropriate

fields on the trial balance worksheet. Note that, for 11208 trial balances, rental
expense detail worksheets are required for 8825 and RENT depreciation.

Enter 8825 and RENT depreciation amounts in the detail work-

N OTE sheets for importing purposes, but be aware that the 8825 and

RENT screens in the program have to be edited if 4562 detail
screens (see Figure 39) are used.

When the trial balance is imported, the COGS depreciation expense amount flows
directly to the appropriate line of Form 1125-A of the return, and the rental deprecia-
tion expense amounts flow directly to the appropriate lines of the 8825 and RENT
screens, as applicable. Because the remaining depreciation can comprise any number
of assets, the amount entered on the trial balance does not flow to the return. To ensure
that each component of the total remaining depreciation is calculated into the return,
each asset must be entered on the applicable depreciation screens in data entry
(Figure 39).

Depreciable Assets
562 Depreciation - Detail ltem

] 4562 Part1
7 4562 Parts 2 and 3
8 4562 Parts 4, 53, and 6
4562 Parts 5b and 5¢
10 Additional Depreciation Elections

Figure 39: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation
on the override screens (screens 6, 7, 8, and 9).

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way
to check that the amount on line 1 of Schedule M-1 is correct. Compare

N OTE the calculated line 1 at the bottom of the trial balance to the equivalent

line on Schedule M-1 of the calculated return. If the depreciation
amounts match but the line 1 amounts differ, an M-1 adjustment could
be required.

The following information applies only to S corporations with multiple rental proper-
ties.

The S corporation trial balances include lines for rental income and expenses
(Figure 40 on page 59). Both rental expense items require a trial balance detail work-
sheet.
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Account Title

Debit Credit Import to: Reported on:

Cash

Trade and accounts receivable

Alloweance for bad debts
Snran i, g

s
P P o

PR

30
TR LS NSRE USRS T S

PP

F0
F0

L, line 1, col d Form 11205, Sch L, line 1, col

L, line 2a, col c Form 11205, Sch L, line 2a, col ¢

Form 11205, Sch L, line 2a, col ¢
- S e sk,

L, line 2b, col ¢
PR S N S FAPFCNPE

T 1 A s PP

Sch K, line 163, Sch -1, Line 5

T i B

K, ling 163

Tax-exempt interest
Gross real estate rental income
Total real estate rental expenses

8525, line 2
Real Egate Rental Exp

Form 8825, line 2

F600 reguires detsil
Gross other rental income kili] REMT, line 1 Rert, Line 1
Tatal other rertal expenses $0 Ciinar Rzl B reguires detail j
Gross rovalties 600 K, line 6 Schedule K| line &
Capital gai I i) cletal i Schedule O
- SPORE GRS O 95585 st o ot ST irn, o STplane S B s e, B, SISO S L

Figure 40: Rental expense rows on an S corporation trial balance worksheet

When imported, the rental expense data entered on the trial balance worksheet appears
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than
real estate).

Because the trial balance worksheet has only one detail screen per rental type, the
importing function does not accommodate entities with multiple rental properties or
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1.
2.

g

NOTE

NOTE

Calculate the totals for both types of rental expenses.

Enter the income totals on the trial balance sheet and the expense totals on the
applicable detail sheets (Figure 40).

Ensure that the balance sheet is in balance.

Import the trial balance worksheet into the return. The applicable screens in data
entry now contain the figures entered on the trial balance worksheet.

Enter the amounts on additional screens that require details. (For more informa-
tion on data that cannot be imported, see “Special Conditions” on page 56.)

Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on
the calculated return to ensure that they match.

If the amounts do not match, review the imported amounts to ensure
that all data was imported. If the data appears to have imported cor-
rectly, an M-1 adjustment could be necessary.

Complete all 8825 or RENT screens in data entry, as applicable, for the individual
rental properties or items.

Delete the 8825 and RENT screens that were imported from the trial balance (the
screens reflecting the total rental expenses).

To delete a screen in data entry, open the screen and press CTRL+D. If
a multiple forms list appears, ensure that the screen to delete is
selected, then click Delete.

Tax Year 2015

59



Form 3115, Application for Change in Accounting Method Drake Software Manual Supplement: 11208

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item.

Form 3115, Application for Change in Accounting Method, is eligible for e-file.

Drake customers can fill out and e-file Forms 3115 and related schedules and attach-
ments for corporation returns.

In some cases, Form 3115 must still be paper-filed. See IRS
instructions for details.

N OTES Applicants filing Form 3115 should refer to Rev Proc. 2015-13 for
general automatic change procedures, and to Rev Proc. 2015-14
for a list of automatic changes to which the automatic change pro-
cedures in Rev. Proc. 2015-13 apply.

Accessing Screens for Changing Accounting Method

Several screens may be required for completing Form 3115. These screens are accessi-
ble from the Change in Accounting Method box, located under the first Other
Forms tab of the Data Entry Menu (Figure 41).

Other Forms | ther Forms | Miscellaneous | State

7004  Application for
8027 Tip Income an
8082 Administrative /

General | Assets-Sales-Recapture | Credits

F Farm Income and Expense
M Schedule N

Schedule K-1 Received
K1F Schedule K-1 from a Fiduciary
K1P Schedule K-1 from a Partnership

RENT Rental (Non-Real Estate)
92 Debt Discharge

2220  Underpayment of Estimated Jax 8825 Rental RealE
Election as a Small Business Corpgration 8832  Entity Classific
2553 Election Information
SH Shareholder Information
8883 AssetAllocatio
8903 Domestic Prod
8925 Report of Empl
FBAR  Foreign Bank
FACY Frequently Ask

2848 Power of Attorney

Change in Accounting Method
3115 Change in Accounting Method

31ME Schedule E

Explanations and Attachments
PtllLn 12 & Pt1Il Ln 23b Attachment

B

Figure 41: Screens for Form 3115, Application for Change in Accounting Method
The screens accessible from the Change in Accounting Method section include:

® Screen 3115 (Change in Accounting Method) — Used to access fields for Form
3115, including Schedules A through D

® Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-
zation methods

¢ Screen ATT (Explanations and Attachments) — Used to create and view cer-
tain attachments to be generated by the software
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* Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete
certain parts of Form 3115 that require specific attachments

When you open screen 3115, the program displays the first of six tabbed screens. As
shown in Figure 42, you can access the various 3115 screens by clicking a tabbed link
at the top of any of the 3115 screens.

Gam Part Il Parts IIl. IV AB.C D-Parts 1.l D-Partlll )
Form 3115 - Application for Change in Accounting Method

General Information

Principal business activity code number, =
Tax year of change begins =

Tax year of change ends

s ‘
. <lame ofaaalicant O gBerei QIS s Lt At NN gty

Figure 42: Tab links on 3115 screen

Multi-form  All 3115 and related screens contain a Multi-form code text box (shown in Figure 42)
Codes that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-

cation you create in Drake. The first should be 1, the second 2, and so on. When using
other screens, such as the 311E or ATT screens, you can use those numbers to indicate
which instance of Form 3115 the 311E or ATT screen should be associated with.

N OTE If only one Form 3115 is being submitted, you do not need to enter any-
thing in the Multi-form code box.

Click Screen Help in the upper right corner of screen 3115 to access
Tl P links to Revenue Procedures 2015-13, 2015-14, and 2015-20 through
the IRS website.

Notices of In addition to Form 3115 and related schedules and statements, the program produces
Missing EF Messages (as applicable) when the return is calculated. All forms, schedules, EF
Attachments  messages, and worksheets are accessible from View mode.

EF Messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements,
specifically, are missing. To best understand which attachments are still required,
compare the ATT screen and the EF_ PDF~ worksheet to the list on the EF message.

All EF Messages must be eliminated before the return is eligible for
N OTE e-file. EF Messages for Form 3115 attachments are eliminated
when all required statements have been attached to the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporation tax return from
a trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

¢ Eliminates the need to duplicate entries
* Eliminates data entry errors by automatically importing data to the correct fields

* Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Trial Balance Import: General Process

Prepare to use Trial
Balance Import

- Enable Excel macros

- Disable autobalance

- Force Schedule L

- Delete unnecessary detail worksheets

.990-PF return?

Populate Trial Balance

Template
(Import > Trial Balance Import)

- direct entry data (cells with $o)
- applicable detail worksheets
- totals for:

- depreciation

- Schedule L

- rentals (1120S & 1065 only)

Populate Data Entry

Enter any trial balance data that cannot be
imported via Trial Balance Import

- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets
(depreciation)

YES

990, 990-EZ, or

4 00 vV —

Make
corrections in

TB worksheet

Compare M-1, line 1: Does trial balance
match Schedule M-z, line 1?7

. _YES»

NO

Did data
import
correctly?

Isan M-1
adjustment
necessary?

YES

Make M-1
adjustment

Adjust
amounts

elsewhere in
data entry

1120S & 1065:
—NO} Were rental totals entered
in trial balance?

YES

Go to data entry an |
enter individual |
rentals on 8825 or |
RENT screens as
applicable

Delete imported
8825 and RENT
screens

Process

complete!
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Index

Numerics
52-53-week year returns 44

A

accounting method

changing 60—61

entering 6
accumulated adjustments account (Schedule M-2) 36
address

change of 6

e-mail 19

entering on Form 11208 5

foreign 26

on K-1 letter heading 29

out-of-state 4
adjusted basis worksheet 29, 43
adjustments

depreciation 34

section 481 8

to income and expenses 40
advertising expenses 12
amended

1120S returns 6, 18

K-1 letters 29
amortization 13, 32
analysis of accounts (Schedule M-2) 35-38
APPT screen, see Multi-State apportionment
asterisks (on K-1 codes) 25
attachments

binary (PDF) 46—49

Form 8825 statements 40

to Form 3115 60
autobalance 33

B
bad debts 8, 10
basis 2930
see also adjusted basis worksheet
binary (PDF) attachments 4
book-to-tax differences (Schedule M-1) 33, 34
Business Activities Statement 24
business activity codes 6

C

calendar-year returns 5

Change in Accounting Method 60—61
change of name or address 6
charitable contributions 24
Client Communications Editor (for letters) 29
codes
business activity 6
error/reject 46
K-1 25, 44
miscellaneous (screen 1) 4
multi-form 38, 61
state 19
compensation of officers 9
compensation of shareholders 9
contact information (for state returns) 19
cost of goods sold, see Schedule A (Cost of Goods Sold)
cover letters (K-1) 29
coversheets 44
credits 40
Ctrl+W (detail) worksheets 7, 8, 50

D

data entry
for state information 19
importing trial balance into 49—59
dates
of incorporation 6
payment (changing) 16
tax year 5
decrease to basis 30
deductions 9—13
depletion 12
depreciation 8
and auto-balance errors 33
expense 11
for cost of goods sold (Schedule A) 7
of rentals 38
on short-year returns 6
printing Form 4562 43
trial balance (business returns only) 58
detail (Ctrl+W) worksheets 7, 8, 50
direct debit of balance due 16—17
direct deposit of refunds 15
distributions 36
domestic production activities deduction 27
due dates 16

Tax Year 2015
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E
EF ACK page 1
e-filing
Form 1120S 44
PDF attachments 46—49
statements 32
Elections
Safe Harbor 43
elections 41
statements 42
electronic
funds withdrawal 16—17
signatures (PIN) 17
Employee benefits programs 12
employer identification number (EIN) 6
envelope coversheets 44
error codes 46
estimates
previous-year tax 13
underpayment of 14
expenses 9—13
exporting K-1 data 26
extensions 17

F

filing instructions 44

final return 6

fiscal year returns 5

foreign
addresses for shareholders 26
transactions 15

Foreign Transaction Statement 3, 23

Form 1099 (1099 Miscellaneous) 3

Form 1125E 43

Form 2553 (Election by a Small Business Corporation) 4, 6

Form 3115 (Application for Change in Accounting Meth-
od) 60—61

Form 4136 (Credit for Federal Tax Paid on Fuels) 14

Form 4562 (Depreciation and Amortization) 38, 43

Form 4797 (Sales of Business Property) 8

Form 5471 3

Form 5884 (Work Opportunity Credit) 41

Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)
8,41

Form 6765 (Credit for Increasing Research Activities) 41

Form 7004 (Application for Automatic Extension of Time
to File) 17

Form 8050 (Direct Deposit of Corporate Tax Refund) 15

Form 8820 (Orphan Drug Credit) 41

Form 8825 (Rental Real Estate Income and Expenses of a
Partnership or an S Corporation) 38—40

Form 8844 (Empowerment Zone and Renewal Community
Credit) 41

Form 8845 (Indian Employment Credit) 41

Form 8846 (Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips) 11, 41

Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)
8,41

Form 8873 (Extraterritorial Income Exclusion) 13

Form 8881 (Credit for Small Employer Pension Plan Start-
up Costs) 41

Form 8903 (Domestic Production Activities Deduction) 27

Form 8912 (Credit to Holders of Tax Bonds) 41

Form 8912 (Credit to Holders of Tax Credit Bonds) 41

Form 8916-A (Supplemental Attachment to Schedule M-3)
34

Form 8932 (Credit for Employer Differential Wage Pay-
ments) 41

Form 8941 (Credit for Small Employer Health Insurance
Premiums) 41

Form 8941 (Credit for Small Employer Health-Insurance
Premiums) 13

Form T (Forest Activities Schedules) 12

Form W-2G (Certain Gambling Winnings) 3

G

gains and losses 8
gross receipts 7

H

header information 5

import, trial balance 49—59
inactive returns 43, 45
income 6—8
increase to basis 30
instructions for filing 44
insurance proceeds, income from 8
interest
expense 11
income 8
inventory 7

K

K-1, Schedule for 1120S 24—30

L

labor 9
letters (K-1) 28

viii
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Index

maintenance costs 10
Multi-State Apportionment 20

N

name change 6

net operating losses (NOL) 38
next-year depreciation listing 43
number of shareholders 6

(0

officer compensation 9
ordinary gains and losses 8
other
adjustments account 37
costs (Schedule A) 7
deductions 12
expenses 39
income (loss) 8
ownership
changes 25
percentages 10

P

passive income 13
PDF (binary) attachments 4, 46—49
percentage, stock and ownership 10
PIN (electronic) signatures 17
printing

cover letter for K-1 29

K-1 items 26

line 22a worksheet 13

statements for Schedule L 32

suppressing/forcing documents 43

R

real estate 58
receipts 7
reconciliation
Schedule L and M-2 31
Schedules M-1, M-3 33
references to forms and worksheets 43
refunds
direct deposit of 15
state tax 8
reject codes 46
rent paid on business property 10
rental activities 38—40
repair costs 10
retained earnings reconciliation (worksheet) 43

returns
52-53-week year 44
amended 18
bankruptcy 44
extensions for 14, 17
fiscal and calendar year 5
inactive 45
short-year 5
signing 17
tax-exempt organizations (990) 46—49
updating prior-year 3
revocation of S election 6
rounding shareholder 24
royalties worksheet 2

S

S corporation
changing to 4
electing as 4
termination of 6
Safe Harbor 43
Safe Harbor Elections 43
scanning (PDFs for e-filing) 46
SCH2 screen (for Schedule L) 32
Schedule B (Other Information) 19
Schedule D (Capital Gains and Losses and Built-In Gains)
Parts I, ITI, and IIT 13
Schedule K (Shareholders’ Pro Rata Share Items) 2124
Schedule K-1
supplemental information 27
Schedule K-1 (Shareholder Information) 24—30
Schedule L 43
Schedule L (Balance Sheet per Books) 31-33
Schedule M-1 33, 43
Schedule M-2 3538
Schedule M-3 35
section
179 income limitations 9
481 adjustments 8
shareholders
adjusted basis worksheet 29—30
compensation of 9
foreign addresses for 26
multiple 26
number of 6
rounding 24
Schedule K-1 24
updating data annually 30
short-year return 1, 5
short-year returns 5
signatures, electronic 17
state
address 4

Tax Year 2015
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codes 19

-specific information 19

tax refunds 8, 15
statements

elections 42

tax

and payments 13—14

on fuels, credit for 8

returns, see returns

years (fiscal vs calendar) 5
taxes and licenses 11
termination of S election 6
trial balance import

and depreciation 8

and Schedule L 31, 33

instructions for using 49—59

U

underpayment of estimated tax 14
undistributed taxable income previously taxed 37
updating

an 11208 return 3

shareholder data annually 30

\"

vouchers 13

w

wages 9

Y

Year screen 5

Tax Year 2015
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